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News and Analysis About
Macs, OS X, and Apple

A Mac for all seasons: Why the
Mac has so much staying power

It's always iPhone this and iPad that, but as the sturdy workhorse of Apple’s lineup,
the Mac deserves some praise.

BY DAN MOREN
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et’s hear it for the Mac.

There’s been plenty of ink shed on the meaning and
impact of iPhone and iPad sales in Apple’s most recent
quarters. In and of itself, that’s no surprise: The iPhone is

the company’s biggest product and makes up more than two-
thirds of its revenue. The iPad, on the other hand, has been
struggling, unlike most of Apple’s other devices.

But through it all, the Mac has
quietly kept on doing steady busi-
ness, and | think the sturdy work-
horse of Apple’s lineup deserves
some accolades. Not only has the
Mac entered its fourth decade—
impressive for any piece of technol-
ogy—but it’'s seen tremendous
success and even growth in an era
where all anybody can talk about is
smartphone this and tablet that.

DON’T CALL IT A COMEBACK

The Mac’s success is especially

Cook is fond of reminding us on
every quarterly conference call, the
Mac routinely experiences growth
despite the contraction of the overall
PC market. Ten years ago, Apple was
selling 3 or 4 million Macs in a year.
In 2015, it topped 20 million. While it
may be only a small chunk of the
company’s overall revenue, the Mac
has maintained an upward trend for
the last decade.

It's hard not to attribute much of
that success to
the so-called |

heartening for someone like me, who  “halo effect,” the THE MAC ROUTINELY
grew up in the late ‘80s and early fact that sales of EXPERIENCES

‘90s, when the platform was a target other Apple GROWTH DESPITE

for jeers and the company name products—first THE CONTRACTION
seemed to perpetually appear with the iPod and OF THE OVERALL PC
that good old “beleaguered” adjec- now the MARKET.

tive in every news story. No matter iPhone—have L
how much we asserted the merits of
the Mac, we were told that it was
nothing more than a niche product,
okay for creative use, but not suffi-

cient for real work.

encouraged

users of PCs to switch to Macs
instead. And there has remained a
certain cachet in the brand that has
probably attracted younger folks
when they purchase their first
computers.

Twenty-some years later, and the
worm has certainly turned. As Tim

7
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THE ERA OF THE MAC

But given the longevity and success
of Apple’s personal computer line, |
think there’s something more at work
here. By and large, the mission of the
Mac hasn’t changed for 32 years:
Computing made simple. As much as
we get done with our smartphones
and tablets these days, and as much
as we may get done with our VR
goggles or smartwatches in the next
couple of decades, the computer
remains a compelling device.

I've said before that the iPad is
unlikely to dethrone my Mac (go.
macworld.com/ipadwontreplace) as
my daily work machine, and while a
lot of that may be due to the muscle
memory of a device that I've been
using regularly for twenty-five years, |
think it also speaks to the Mac’s
continued relevance.

More than ever, popular apps and
services are built to work with the
Mac first, not as an afterthought, and
more than that, creators of those
products have internalized the cues
first pushed by Apple years ago

A MAC FOR ALL SEASONS

when the Mac debuted: Good
design, pleasing aesthetics, simplic-
ity, and user-friendliness.

The Mac may not rack up the sales
of the iPhone, or even the faltering
iPad, but it has to be acknowledged
that the Mac laid the groundwork to
make those devices possible. The

overall philosophy of the Mac has, in
the end, emerged victorious.

LONG LIVE THE MAC
| also can’t discount the power of
emotion. | love my Macs—always
have. And despite the fact
that | carry my iPhone with me
everywhere | go, I've never
quite developed the same
attachment, in part because
| trade in my iPhones nearly
every year. By contrast, my
iMac, on which | type this,

is nearing the five-year
mark. There’s an old Blue |
& White G3 sitting next to L
my desk. Somewhere in ;»..'g-jﬂliilé.'l_”'""
the mess that is my
office is my PowerBook

THE MAC MAY NOT RACK UP THE

SALES OF THE iPHONE, OR EVEN .
THE FALTERING iPAD, BUT IT HAS
TO BE ACKNOWLEDGED
THAT THE MACLAID THE  \ \ -—_
GROUNDWORK TO MAKE ~ \————=d
LTHOSE DEVICES POSSIBLE. e N



http://www.softgozar.com

G3, one of my favorite Macs of all
time—and the first laptop | ever
owned.

Nostalgia is a powerful force, and
given that I've spent the majority of
my life using a Mac, it’s no surprise
how many memories are tied up with
the platform. From typing my first
stories as an elementary schooler, to
writing papers in high-school, to
editing videos in college, the Mac’s
been there at every stage of my life.

During my tenure at Macworld,
people used to suggest with reason-
able frequency that the name was
obsolete, and the publication would

be better off as something more
topical: “iPodworld,” “iPhoneworld,”
or even just “Appleworld.” The former
seems positively archaic these days,
but even the latter strikes me as
potentially transient in the grand
scheme of things.

Thirty-two years later, the Mac is
still chugging along, and while it's
occasionally been eclipsed by the
meteoric success of its newer,
flashier siblings, it's never really
fallen out of favor. The Mac has
proved its staying power, and if the
past three decades are any indica-
tion, it’'s got plenty of life left. m
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Why the FBI’s request to
Apple will affect civil rights
for a generation

No legal case applies in a vacuum, and in this case the FBI needs the
precedent more than the evidence.

BY RICH MOGULL

10
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n February 23, the United States District Court of
California issued an order (go.macworld.com/fi
appleorder) requiring Apple to assist the FBI in
accessing a locked iPhone—and not just any iPhone,
but the iPhone 5¢ used by one of the San Bernardino shooters.
The order is very clear: Build new firmware to enable the FBI to
perform an unlimited, high-speed brute force attack, and place

that firmware on the device.

Apple is not only fighting the
request (go.macworld.com/oppose
courtorder), but posted a public
letter (go.macworld.com/tcletter)
signed by Tim Cook and linked on
Apple’s front page.

Make no mistake: This is unprec-
edented, and the situation was
deliberately engineered by the FBI
and Department of Justice to force a
showdown that could define limits to
our civil rights for generations to
come. This is an issue with far-
reaching implications well beyond a
single phone, a single case, or even
Apple itself.

As a career security professional,
this case has chilling implications.

WHY NOW?

I've been writing about Apple’s role
in our digital civil rights (tidbits.com/
article/15137) since 2014, and recently
specifically addressed why Apple is
at the center of the battle over
encryption (tidbits.com/article/16210)
on TidBITS. The short version is that

[ T r————

Apple is one of the only companies
with the technologies, high profile,
and business model to both find itself
in the cross hairs, and take a strong
position.

Make no mistake, Apple has a long
history of complying with court
orders and assisting law enforce-
ment. Previous to iOS 8, they could
extract data off devices. Even today,
data in most of their online services
(iCloud, excluding iMessage and
FaceTime) can be provided upon
legal request.

This case is different for multiple
reasons:

> Apple is being asked to specifi-
cally create new software to circum-
vent their security controls. They
aren’t being asked to use existing
capabilities, since those no longer
work. The FBI wants a new version of
the operating system designed to
allow the FBI to brute force attack
the phone.

> The FBI is using a highly emo-
tional, nationally infamous terrorism

1"
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case as justification for the request.

> The request refers to the All
Writs Act, which is itself under
scrutiny (go.macworld.com/effallwrits)
in a case in New York involving Apple.
Federal Magistrate Judge James
Orenstein of the Eastern District of
New York is currently evaluating if the
Act applies in these cases.

> That’s why this is about far more
than a single phone. Apple does not
have the existing capability to assist
the FBI. The FBI engineered a case
where the perpetrators are already
dead, but emotions are charged. And
the law cited is under active legal
debate within the federal courts.

The crux of the issue is this:
Should companies be required to
build security circumvention tech-
nologies to expose their own custom-
ers? Not “assist law enforcement with
existing tools,” but “build new tools.”

The FBI Director has been clear
that the government wants back
doors into our devices (go.mac
world.com/fbibackdoor), even
though the former head of the NSA
disagrees and supports strong
consumer encryption (go.macworld.
com/haydenencryption). One reason
Apple is likely fighting this case so
publicly is that it is a small legal step
from requiring new circumvention
technology, to building such access
into devices. The FBI wants the
precedent far more than they need

Coft oXar.oom

THE FBI AND APPLE

APPLE HAS BEEN
PROMPTING users to
choose longer and
more complicated—
and harder to crack—
iPhone passcodes.

Custom Alphanumeric Code

Custom Numeric Code

4-Digit Numeric Code

Don't Add Passcode

Cancel

the evidence, and this particular
case is incredibly high profile and
emotional.

The results will, without question,
establish precedence beyond one
killer’s iPhone.

THE TECHNICAL DETAILS
The court order is quite specific. It
applies only to one iPhone, and
requests that Apple create a new
version of the firmware that elimi-
nates the existing feature that
erases the iPhone after 10 failed
attempts at entering the passcode.
It further asks Apple to allow pass-
code attempts to be performed as
rapidly as possible.

Beginning with iOS 8, devices are

12
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encrypted using a key derived from
your passcode. This is combined with
a hardware key specific to the
device. Apple has no way of knowing
or circumventing that key. On newer
devices, the hardware key is embed-
ded in the device and is not recover-
able. Thus the passcode must be
combined with the device key in a
chip on the phone, and that chip
rate-limits passcode attempts to
make a brute force attack slower.
Reading through the order, it seems
the FBI thinks that a modified version of

the device first checks whether
the firmware has a valid signa-
ture from Apple. This signature
check is why the FBI cannot load
new software onto an iPhone on
their own—the FBI does not
have the secret keys that Apple
uses to sign firmware.

This opens up a few questions. Could
this work on newer devices with the
enhanced encryption of the Secure
Enclave (go.macworld.com/secureen-
clave)? How can Apple pair the device

the operating system would allow them
to engage in high-speed attacks, if the
10-tries limit was removed. The request
indicates they likely can’t image the
device and perform all the attacks on
their own superfast computers, due to
that hardware key. With a four-character

and replace the firmware in the first
place? Would they be using the
shooter’'s computer? An over-the-air
update? Apple says that all devices
(with or without the Secure Enclave)
are vulnerable

to this kind of [

passcode the device could probably be  attack, but A SIX-CHARACTER
cracked in hours. A six-character code declined to CODE MIGHT TAKE
(go.macworld.com/6digitpwd) might comment on DAYS OR WEEKS,
take days or weeks, and anything the specific AND ANYTHING
longer could take months or years. technical LONGER COULD TAKE

Dan Guido over at Trail of Bits methods, a MONTHS OR YEARS.
posted a great explanation: position | l

initially dis-

As many jailbreakers are agreed with, but on reflection is
probably the right move for reasons
we will get to in a moment.

Thus the FBI wants a new version
of iOS, signed by Apple and installed
on the device, that removes limitations
on their attempts to brute-force the

password.

familiar, firmware can be loaded
via Device Firmware Upgrade
(DFU) Mode. Once an iPhone
enters DFU mode, it will accept
a new firmware image over a
USB cable. Before any firmware
image is loaded by an iPhone,

13
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WHY THIS MATTERS

Legal precedent is like a glacier,
slowly building over time until it
becomes nigh unstoppable. Major
issues like this are first, and some-
times ultimately, decided on a series
of small steps that build on each
other. It's the reason the NRA fights
any attempts at gun control, since
they fear a slow build, not a single
small law.

The crux of this round of the
encryption debate is if companies
should be forced to build tools to
circumvent their customers’ security. If
the answer is “yes,” it could be a small
step to “should they just build these
tools into the OS from the start?”

| have no doubt the FBI deliber-
ately chose the highest-profile
domestic terrorism case in possibly a
decade. We, average citizens, want
the FBI to stop this sort of evil. We
don’t necessarily see this one case
as applying to our lives and our
rights. Why the big deal? What if the
FBI could find the terrorists’ contacts
and stop other attacks?

But the truth is that no legal case
applies in a vacuum. If this goes
through, if Apple is forced to assist, it
will open a floodgate of law enforce-
ment requests. Then what about civil
cases? Opening a phone to support
a messy divorce and child custody
battle? Or what about requests from

THE FBI AND APPLE

other nations, especially places like
China and the UAE that already
forced BlackBerry and others to
compromise the security of their
customers?

And once the scale of these
requests increases, as a security
professional | guarantee the tools will
leak, the techniques will be exploited
by criminals, and our collective security
will decline. It really doesn’t matter if
it's the iPhone 5c¢ or 6s. It really doesn’t
matter if this is about dead terrorists or
a drug dealer. It doesn’t matter what
specific circumvention Apple is being
asked to create.

What matters is if we have a right to
the security and privacy of our
devices, and of our communications,
which are also under assault. If we
have the right to tools to defend
ourselves from the government and
criminals alike. Yes, these tools will be
sometimes used for the worst of
crimes, but they’re also fundamental
to our civil rights, freedom of dis-
course, and our ability to protect our
digital lives from the less impactful,
but far more frequent criminal attacks.

This situation was engineered by
the FBI and Department of Justice for
the maximum impact and chances of
success. Apple is fighting, and as a
security professional it’s my obliga-
tion to support their position, and
stronger security. B

14
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You might know JOShua

He loves video games, and he
owns enough to know they’re not
all meant for kids. That’s why he
reminds his friends (at least the
ones that have kids) that they all
have big black letters on the box
to help parents find the ones that
are best for their families.

You can learn about those
ratings at ESRB.org

C
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Apple TV vs. Amazon’s Fire TV:
The gaming match-up

We put the set-top boxes up against each other on game selection,
remotes, and more.

16
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hen it comes to gadgets, Apple and Amazon tend
to have very different audiences. Consider tablets,
for example: Amazon’s entry-level Fire tablet is
priced at a stunning $50, while Apple’s cheapest
active iPad (2013’s iPad Mini 2) sells for $269. There’s a notice-
able gap in quality between the two in many regards, but Ama-
zon'’s focus on cheap, usable tech contrasts sharply against
Apple’s higher-end polish and performance.

The difference is less obvious when Game on? Game on! We've already

it comes to set-top boxes, however. put the Apple TV through its gaming

Last fall's overhauled Apple TV was a  paces, sharing our early impressions

big leap for the device, adding apps (go.macworld.com/appletvgaming)

and games along with the touchpad and highlighting some of the best

remote, but Amazon had already games (go.macworld.com/10appletv

mined that territory with the first Fire games) and gamepads (go.macworld.

TV. Right after the Apple TV was com/appletvgamepads) alike. But

released, Amazon refreshed the Fire after spending the last couple weeks [7°S NOT AS ELEGANT an

TV with added processing power, 4K with the latest Fire TV, we think interface as Apple’s,

resolution support, and other there’s healthy competition here. If but then again, it's not
. super easy to find the

enhancements. And the price you're an Apple fan, should you really apps and games you

difference isn’t quite so dramatic. grab an Amazon box? Maybe, and want on either box.

Your Apps
Library

Inferno 2 4  CrossyRoad FOX Sports GO Robreed: Flippi.

Popular Lists

NEW YEAR
NEW YOU

Spotlight


http://www.softgozar.com

maybe not—here’s our take.

THE BASICS

As you may know from reading this
very publication, the current-gen Apple
TV sells for $149 with 32GB storage or
$199 with 64GB, and comes with the
unit itself, the touchpad-equipped Siri
Remote, a power cord, and a Lightning-
to-USB charging cable for the remote.
It's powered by the same dual-core,
64-bit A8 chip from the iPhone 6 and
iPad mini 4, along with 2GB RAM
inside, and runs at a maximum resolu-
tion of 1080p on your TV.

Meanwhile, the new Fire TV sells
for $100 in one configuration with
8GB of internal storage, although you
can increase that tally significantly
with a microSD card. Otherwise, you
get the unit, a non-touch remote
control, and the power adapter. It
runs off of a MediaTek quad-core
processor with 2GB RAM, and can

Coft oXar.oom

APPLE TV VS. AMAZON’S FIRE TV

play 4K resolution media (movies and
TV shows) on a compatible TV.

In both cases, you get a compact,
HDMI-connected black box and a slim
remote to control it. With the Fire TV,
you save $50 off the entry-level Apple
TV but get a less-capable remote and
much less storage—so much so that
you'll probably want to spring for a
microSD card to store more apps and
games. Otherwise, both do a lot of the
same things: They run Netflix and
Huluy, tap into each company’s respec-
tive media offerings, and can play
their own games and apps.

GAME SELECTION

When it comes to gaming on the Apple
TV and Fire TV, there are more differ-
ences than similarities, surprisingly.
Some common games exist between
platforms (more on that shortly), but the
overall shape of each library reveals
stark differences in approach so far.

18

MANY APPLE TV GAMES
are ports of ideal
iPhone experiences,
like Alto’s Adventure
here—Iluckily, many of
them (Alto included)
hold up well.
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Look at the Apple TV App Store
and you're likely to find a whole lot of
iOS ports. There’s some really great
stuff in the mix, including Alto’s
Adventure, Badland, and Oceanhorn,
but many of the releases are already
available on your iPhone or iPad—and
if you're reading Macworld, we have a
feeling an Apple TV probably isn’t (or
won'’t be) your first Apple device.

There are also games that started
on PC and/or consoles and then hit
iOS en route to the Apple TV, such as
Transistor, Geometry Wars 3: Dimen-
sions Evolved, and Octodad: Dadliest
Catch, and those are all better enjoyed
on the big screen with a gamepad.
And there are a handful of noteworthy
original Apple TV experiences, as well,
such as Galaxy on Fire: Manticore
Rising and Beat Sports, along with
peripheral-based console game ports
like Guitar Hero Live, Disney Infinity
3.0, and Skylanders Supercharged.

The Fire TV also has mobile-to-TV

ports, like Pac-Man 256, Crossy
Road, Badland, and Riptide GP2, but
more noticeably, it has larger-scale,
controller-centric games that the
Apple TV doesn’t. Most crucially, it
has Minecraft: Pocket Edition, which
is delightful with a gamepad, but it
also has Telltale Games’ excellent
episodic adventures, including The
Walking Dead, Tales from the Border-
lands, and Minecraft: Story Mode.
And the list goes on a bit: You can
grab huge classic console games like
Grand Theft Auto lll, Vice City, and
San Andreas, as well as Star Wars:

=i |

THISIS
MINECRAFT:
POCKET EDITION
onaniPhone,
butimagine it
on a big screen
without all the
extra Ul junk—
it’s swell.

DISNEY INFINITY 3.0,
which is played with
smart figurines and a
Bluetooth-connected
base, is one of the
rare big, console-style
games on the Apple
TV. And it’s Star Wars!
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Knights of the Old Republic and
beloved Final Fantasy and Sonic the
Hedgehog games. The Fire TV also
has Shovel Knight, a beloved recent
console homage to old-school 2D
games, along with great Mac games
like Luftrausers, Read Only Memo-
ries, OlliOlli, and Titan Souls.

The more | browsed the listings,
the more | found Fire TV gems that
aren’t on Apple TV—yet, at least. And
because all Apple TV games must
offer Siri Remote support, many of
those games may not arrive anytime
soon. The Fire TV lets creators sell
games that require the gamepad,
which is another $50, but it opens up
the possibilities so much. It allows
the Fire TV to effectively bridge the
gap between what you can play on
your phone and what you could play
on a game console or computer.

YOU WON'TFIND Telltale’s
episodic adventure games, like
The Walking Dead, on the Apple
TV—not right now, at least.
Surely someday, we expect.

“oft orar.com

APPLE TV VS. AMAZON’S FIRE TV

PERFORMANCE

When it comes to games that are on
both the Apple TV and Fire TV, the
differences are small but worth noting.
Generally, if there’s a difference, the
Fire TV versions run a little more
smoothly. That was very evident with
Asphalt 8: Airborne (go.macworld.
com/asphalt-ios), which frustrates on
the Apple TV with frame rate hitches—
but on the Fire TV, it's smooth sailing.
In both cases, you'll have to deal with
waiting around and downloading big
chunks of extra content before you
can play, but the in-game action is
slicker on Amazon’s device.

Same for Crossy Road, which runs
fine on the Apple TV but has little
split-second hitches here and there—
it's even visible during the developer’s
Hipster Whale logo. But on the Fire
TV, that’s not an issue. Not every
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game has noticeable differences:
Twin-stick shooter Xenowerk (go.
macworld.com/xenowerk) runs about
the same on both boxes, as do
Pac-Man 256 and Badland. In any
case, the performance differences in
those earlier games aren’t dramatic,
but they are there.

REMOTE PLAY
When it comes to the bundled
remote control, there’s no doubt
about it: Apple’s Siri Remote is much,
much better for games. It’s not an
ideal device for all types of games, as
discussed in our initial Apple TV
gaming impressions (go.macworld.
com/appletvgaming), but it’s versatile
and responsive enough to handle a
lot of different inputs between the
touchpad, motion controls, and physi-
cal buttons.

| can’t say nearly as much for the
Fire TV remote, which is a more
traditional button-based option. It
doesn’t have any touch or tilt move-
ment whatsoever, and it’s not config-
ured to be any more useful for
games when held sideways like a
gamepad. The primary input is a
large button surrounded by a direc-
tional pad, much like the last-gen
Apple TV remote—and that’s fine for
something like Crossy Road or
Pac-Man 256. Not great, but usable.

Switch to Asphalt 8: Airborne, how-
ever, and the default control scheme

O RF..Oom

is terrible, trying to convince you that
it's possible to hold the button to
accelerate and then also steer with
the surrounding directions. Turn on
auto-acceleration and it’s playable,
but still not very comfortable. Jet ski
racer Riptide GP2 is likewise playable
with the remote, but there’s no
nuance to the streamlined steering,
and you’ll bump up against the sides
a lot more.

Many Fire TV games require the
gamepad, while most others are just
way, way better with it. In other words,
if you’re not willing to pay extra for the
gamepad, don’t get a Fire TV to play
games. It's clear that games are a very

THE SIRIREMOTE (left) packs a lot of functionality
into a tiny space. Amazon’s remote does a lot less.
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small perk out of the box, but only a
real benefit if you shell out for the
controller. At least Amazon sells a
Gaming Edition bundle (go.macworld.
com/firetvgamingedition) with the
box, a gamepad, and two games
(Shovel Knight and DuckTales Remas-
tered) for $140—a nice savings.

GAMEPADS

Apple doesn’t make its own official
Apple TV gamepad, but there are
several licensed MFi (Made for iOS)
controllers that work well with it—and
the recent SteelSeries Nimbus (go.
macworld.com/nimbus) and Hori
Horipad Ultimate (go.macworld.com/
horipad) also have the Apple TV Home
button clearly marked. My pick is the
Nimbus ($50), which feels great in the
hand, is nicely sturdy and responsive,
and has a battery pack that you charge
with a Lightning cable. It's a near-con-
sole quality device, although again,
you've got options and we’ve covered
most of them (go.macworld.com/
appletvgamepads).

APPLE TV VS. AMAZON’S FIRE TV

Meanwhile, Amazon has its own Fire
TV Game Controller ($50) (go.mac
world.com/firetvgamecontroller),
which was revised for the latest Fire TV
model, and it’s also very good. The
gamepad is nicely contoured and the
buttons are very responsive, plus it has
perks like a headphone jack for
pumping in audio from the box, as well
as a microphone for voice commands.
The downside is that it takes AA
batteries, but Amazon says that two of
them last for upwards of 90 hours.

Some other controllers—which you
might have laying around—also work
with the Fire TV, including Xbox 360
controllers (connected via USB) or an
OnLive gamepad—although you
might have to fuss with the in-game
settings to get them properly config-
ured. Reddit has a whole thread
(go.macworld.com/firetvaltgame
controllers)about alternative options
and troubleshooting, if you care to try.

Really, it's pretty much a wash
between the SteelSeries Nimbus and
the official Fire TV Controller: Both feel
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pretty good, work well, and are the
same price, so there’s not much of a
sway here in either direction. The Fire
TV Controller is a lot more mandatory
for its box, given the wealth of
controller-only games on Amazon'’s
storefront, but the Apple TV needs a
gamepad for serious gaming too. It's a
worthwhile expense in both cases.

THE VERDICT

If you're already deep into the Apple
device and app ecosystem, the
Apple TV is an easy buy: An ever-
increasing number of your existing
games and apps transfer over with
ease and you can tap into Apple’s
own media services on top of all that.
Furthermore, the Siri Remote has
more flexibility as an input device,
and the Apple TV interface and
storefront are leaps and bounds
better than Amazon’s.

However, if you're looking to play
larger, more complex, and particularly
console-like games on your TV rather
than a phone or tablet, | have to give
the slight nod to the Fire TV at this
time. With the option for gamepad-only
games, the Fire TV's library has big,
engrossing games you just can’t find
on the Apple TV right now, including
Minecraft, The Walking Dead, and
Game of Thrones, plus classic Final
Fantasy and Grand Theft Auto entries.

On the other hand, the Apple TV
has Transistor, Lumino City, Oceanhorn,

[ T r————

Guitar Hero Live, and Disney Infinity
3.0—not to mention a very strong array
of smaller but still great experiences.
Both platforms have excellent games
that aren’t found on the other (as of
this writing), but | find both quality and
quantity in the Fire TV listings when it
comes to larger-scale games. And
when there’s a performance difference
between the same game on both
platforms, it's in favor of the Fire TV
version in my experience.

Keep in mind that the gaming value
of the Fire TV is almost entirely depen-
dent on buying a gamepad. Without it,
the Fire TV has a small collection of
decent games, but certainly not
enough to buy a set-top box for. And |
don’t think that’s going to change—the
Fire TV’s main remote isn’t designed
for even lightly complex games.

But the situation could change for
the Apple TV. It has been on the
market only a short while now, and
the game library will continue
expanding and evolving—and I'm
sure Telltale’s games will be adapted
for the Siri Remote, and perhaps
other noteworthy Fire TV games will
follow too. At some point, | expect
Apple will cave on the Siri Remote
requirement for games, allowing
more complex fare like Minecraft to
make a smooth transition over. Until
then, the Fire TV has extra gaming
allure that the Apple TV can't fully
match. |
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MACUSER

MAC GEMS ARE APPS THAT OFFER
STANDOUT UTILITY OR UNIQUE
FEATURES AT A GREAT PRICE.

UTILITY

TPASSWORD 6 FOR MAC:
ENTERPRISE FEATURES AND
LOTS OF SMALL IMPROVEMENTS

BY MARCO TABINI

UNLESS YOU'VE BEEN living under the proverbial rock, there’s a

good chance that you have, by now, become aware of how tragically 1PASSWORD 6
easy it can be for your online credentials to be stolen. From picking FOR MAC
weak combinations of characters that can be easily guessed—it’s ““‘
somewhat sad that, in 2016, password is still the most common PRICE WHEN RATED
passphrase—to reusing the same password across multiple websites, $50 single-user license
it doesn’t take much to make a mistake that could very well turn out COMPANY
to be fatal. AgileBits
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While there is no bulletproof solution to this problem, the easiest way
to alleviate it is to engage the services of a password manager—an app
designed to provide an encrypted digital vault in which all your different
logins are stored. This way, you can use completely different (and highly
secure) credentials for each website while only having to remember the
one “master password” that unlocks your vault.

AgileBits’ 1Password (agilebits.com/onepassword) is perhaps one of
the most venerable members of this family of programs, and one that,
with its newest version 6.0 release, aims to retain its position as the
leader of the pack.

A FAMILIAR FACE

Curiously for a major release, 1Password’s user interface has remained
largely unchanged compared to its predecessor. In fact, if you bought
your copy from the Apple Store and you have auto-updating enabled, it’s
entirely possible that you may already be running it without even
knowing!

ene
At the cost of sounding & s @
old and crotchety, | must say D A
L , Categories :.Idv-nhga i
that this is good news. It's Logins SRR s
. [ Secure Notes. J| Adobe
certainly trendy for apps to 5 Crecit Cands =
& Idenities ' s

undergo drastic Ul redesigns Passwords .

. . E Databases e Do
with every major release. i adobeid-nal.services.adobe....
§| Passports

1Password has had its share
of those in the past, but |

#% Reward Programs 7,y adobeicknal.services adobe....

% Software Licenses

Foiders @ NSRRI
happen to think that the s o femphn
current interface works really Socuriey Auc s

. ¥ Watchtower e
well. Thus, new users will U nie s -

gl

enjoy a mature experience 0 3+ years ot S e
U 1-3 years old WE - A

that has been refined over

§ eazmortnecld  m AMEX (Personal)
time, while veterans of o .\,,_;_,;,,m
AgileBits’ software won’t & roe
have to do away with their & A
familiarity and learn how to . e
use the app all over. & rovez
That’s not to say, of % Apozapper
course, that a few tweaks Sl '
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hasn’t changed much—
which means that current
users won’t have to learn
everything from scratch.
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haven’t found their way into 1Password 6. For -
example, the app now features a redesigned f :_ “"r._l‘ Password
setup workflow, and a new Save Login window 7 At

now pops up in your browser when you

register on a website. This last change, in
traffic-ably-trombone o

particular, makes the process of adding new

logins to your digital vault more obvious, thus
reducing the likelihood that you will forget to
save a set of credentials. Regenerate Password

Ch t Words
A PEEK UNDER THE COVERS aracters EMALLE
The lack of flashy Ul changes means that the
meat of 1Password’s new release lies under its

words 3

separator o hyphen
skin, starting with the app’s password generator.

This nifty feature allows you to create ZZT;
cryptographically-secure passwords based on comma
random data. In the past, this has meant ttd underscore e file
having to deal with really complex sequences { MoamEdDec 3T 969 ar a0

of letters and digits like, say, Fmr7M6JwWp.
While undoubtedly safe from a mathematical

perspective, these tended to be...a little hard to use. Not a big problem if ~ THENEWPASSWORD generator
can now use words instead

you can use 1Password to both store and automatically fill web forms
of random characters.

with them, but definitely less user-friendly if you had to either remember
them in your head or type them in by hand.

With version 6, the generator can now be used to combine a series of
words into passphrases that, while still secure, are much easier to
remember and type in. Thus, the old jumble of random characters can
now be replaced by a combination of nouns and adjectives that, while
just as aleatory, are at least easier to recall and type on a keyboard.

A VAULT FOR EVERY TEAM

The ability to share a vault among multiple users has been baked into

1Password since version 5. This very convenient feature relies on some

external synchronization service like Dropbox to create a vault file that

can be accessed simultaneously by different people, and is great, for

example, to keep tabs on all your family logins and other private details.
Unfortunately, this feature has never worked well for groups of people
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in which a higher level of control was required: While it’s unlikely that
one of your relatives will suddenly resign from your family and join a
competing clan, this is a very real possibility in every workplace, for
example.

The latest release of 1Password gains a brand-new feature called
1Password for Teams (teams.Ipassword.com), which combines the
concept of a shared vault with the kind of features you expect in an
enterprise settings, like support for multiple users groups, the ability to
manage access to secure storage with fine-grained access, and so forth.

The product, which is currently in beta and will eventually cost around
$5 a month for each user on a team, comes with a few additional perks, ~ BRINGINGALLTHE data from

R - . your digital vaults together
such as free access to the professional edition of every version of into a single interface is the
1Password, and support for unlimited vaults and storage. All Vaults view.

Clearly, the introduction of all these vault-
centric changes over the last couple of
versions have complicated the lives of those LS 5
who share their data with family and team i
members. Luckily, the app now includes an All ® Primary 381
Vaults view that allows you to work with a
merged view of all your data while keeping =
the contents of each vault physically separate. ﬂ,'

8 Appleseed Family
GROWING PLANS @ Your Vault 382

With the launch of 1Password for Teams, 1) Everyone 83
AgileBits’ business model gets closer to that )

of its competitors, most of which have switched a \C

from one-time purchases to subscription-

based revenues over the last few years. ¥4
Unlike many of its competitors, however, 35

1Password retains the ability to unlock its more

powerful features using a one-time purchase, @ Customer Support ¥6

which feels to me like a smart decision,

particularly in light of the fact that the app is @ Delivery 387

compatible with a number of cloud-based @ Socials 328

synchronization services that most of us are

already likely to access, like Dropbox or (& D)) Everyone 3$9

iCloud.
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As a result, the base version of the app remains free, individual users
can take full advantage of its advanced functionality in exchange for a
reasonable amount of money, and enterprise-level customers enjoy the
kind of flexibility they require with a small monthly expenditure.

BOTTOM LINE [ o
1Password 6 is an incremental release for a great 1PASSWORD’S
product. The lack of flashy new features is made up GREAT FEATURE
for by a focus on advanced features—and the fact that SET, LONGEV'TY,
the upgrade is available as a free update for existing AND ABILITY TO
users, either through the App Store or directly from RELY ON MULTIPLE
AgileBits’ online store. SYNCHRONIZATION

While 1Password remains my favorite digital vault, | SERVICES MAKE
must say that the product is falling behind its competi- THIS APP ONE OF THE
tors in some aspects; for example, several other BEST OF ITS KIND.

L _

password managers now support the ability to auto-
matically change passwords on many popular sites—
something that can greatly increase security by reducing the effort it
takes to keep all your logins fresh and cryptographically sound, and that
is not yet possible with AgileBits’ app.

Its great feature set, longevity, and ability to rely on multiple synchro-
nization services, however, still make this app one of the very best of its
kind. Here’s to hoping that, now that the folks at AgileBits have had an
opportunity to complete their work on 1Password’s enterprise features,
they will once more turn to improvements that have a more direct impact
on helping users get a handle on their digital lives. m

28


http://www.softgozar.com

UTILITY

DISK DRILL PRO 2: LAST LINE OF
DEFENSE FOR MAC DATA RECOVERY

BY J.R. BOOKWALTER

ALTHOUGH FASTER, MORE
DURABLE solid-state disk (SSD)
storage eliminated spinning
platters and therefore reduces
the chance of losing precious
files due to mechanical failure,
there are plenty of other ways
drive-related catastrophe can
rear its ugly head. Frequent
backups are one highly recom-
mended method of protection,
but that alone isn’t enough to
prevent complete data loss.

As the old saying goes, the
best offense is a good defense.
In the case of your Mac, that
strategy involves keeping good
data recovery software on hand
for when a file or—God forbid—
an entire disk partition eventually winds up disappearing without a

trace. (And remember, it's not a question of “if,” but “when.”) DISK DRILL
Unless an afflicted drive craps out entirely—in which case your PRO 2.4
only hope will be paying for costly recovery services like DriveSav- ““
ers—all you need is the right software tool for the job and you’ll be PRICE WHEN RATED
back in business in no time. §89
COMPANY
TO SERVE AND RECOVER 208 Software

Disk Drill Pro 2 (cleverfiles.com) is one such Mac utility for scanning,
recovering, restoring, and protecting OS X files and volume parti-
tions. Also available in free Basic and commercial Enterprise editions,
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REVIEWS | DISK DRILL PRO 2.4

the software provides comprehensive data recovery from any type of
disk media, including USB flash drives and memory cards.
While the Basic edition provides continuous protection with core
features such as Recovery Vault and Guaranteed Recovery along with
the ability to back up failing volumes to a disk image backup (DMG)
stored on an external drive, the Pro version adds a few more robust
options. A single-user license works on up to three Macs, with lifetime
upgrades available for an additional $29.
In addition to the Quick Scan that skims through deleted files
within seconds on even the largest volumes, Disk Drill Pro also offers
Deep Scan, a process that takes significantly longer but has far better
odds of rooting out lost media. | tested the latter option on my 15-inch  DISKDRILLPRO’S Deep Scan
MacBook Pro with Retina Display’s 500GB internal SSD which mode tunnels through your

. . . . volume in search of files
clocked in around eight minutes, and did indeed turn up a respect-

that are capable of being

able number of additional photos, documents, and other files that recovered.
[e] ® Disk Drill PRO [ Quick Scan [ Macintosh HD
Al files (no hidden & system ones) | | over 0KB | deleted within the last [anytime <
Name Kind Size Modification date
¥ B Users (44) Folder 28.1MB
& ¥ (5 jrbookwalter (44) Folder 28.1MB
[ ] ¥ B Library (44) Folder 281 MB
¥ 5 Safari (9) Folder 18.6 MB
@' Bookmarks.plist ¢ ) property list 411 KB 2016-01-286 18:36:51 +...
* | Bookmarks.plist < . property list AN KB 2016-01-26 18:36:55 +.
¥ Bookmarks.plist D L) property list 411 KB 2016-01-26 18:36:56 +.
* | Bookmarks.plist Y property list AN KB 2016-01-286 18:37:06 +.
» E5 ReadingListArchives (4) Folder 16.6 MB
* | Bookmarks.plist 0 property list AN KB 2016-01-26 1B:37:41 +...
¥ [E5 Application Support (6) Foider 26 KB
» [ Caches (11) Foider 33KB
» = Containers (3) Folder 10 KB
¥ [ Preferences (14) Foider 6.2MB
¥ comyahoo.fiickrmac.plist ¢ () property list 443 KB 2016-01-26 18:38:48 +..
* | com.yahoo.flickrmac.plist C i property list 443 KB 2016-01-26 18:38:18 +..
* | com.apple.Safari plist : € property list 1.3 MB 2016-01-26 18:39:15 +
£ 9" com.apple.Safari plist > L) property list 1.3 MB 2016-01-26 18:37:46 +..
l_;M_gllnl found items as disk Did you know you could export forensic recovery data with Disk Drill? Learn more
30
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Quick Scan could not. (s} Disk Drill by CleverFiles
Once a scan has completed,

users preview a file’s contents
using the Quick Look or view in ‘ ; back, would you like Disk Drill

hexadecimal format to assure it’s \ to do the following?
complete prior to recovery. Return-

ing one or more files and folders

from the grave is as easy as Enable data protection on my main drive now ?
making a selection and clicking the

green Recover button in the upper

._ _—> Before we start to get your data

Monitor my disks for hardware issues using S.M.A.R.T.

right corner. The Pro version can Review and manage scanning results as a disk ?
also mount found items as a new
disk, but this feature requires the Show me updated product tour

aging (and occasionally buggy)

Continue -+
Fuse for OS X to be installed. onnue
Disk Drill Pro 2 can also be used
to rebuild the catalog of Mac HFS+
partitions, a task traditionally
reserved for utility software like Or just run Disk Drill in portable mode 7
DiskWarrior. Unlike that venerable |
application, Disk Drill Pro can only
perform a catalog rebuild on partitions that refuse to mount correctly; ATFIRSTLAUNCH, Disk Drill
otherwise this option won’t appear at all in the drop-down menu. walks users through an
extensive tutorial, along
with setting up a few
DRILL DOWN options to help future
Disk Drill’s first major upgrade isn’t actually new: Version 2.0 made its data recovery.

debut nearly two years ago, and developer CleverFiles has been
steadily releasing regular updates ever since, including several that
tuned up the application ahead of last year’s OS X El Capitan. Unfortu-
nately, the user interface has remained largely untouched during this
time.

With Disk Drill 3 on the horizon (currently in beta testing), I'm hoping
the engineers take this opportunity to give the software a fresh coat of
Ul paint. As it currently stands, Disk Drill is a dated, often confusing
morass of options and menus, and it's not always entirely clear which
buttons and options do what.

Part of this stems from how Disk Drill displays volume information
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typically hidden from users. For example, my Drobo 5D and Drobo mini
both show additional EFl and Unallocated partitions, although there’s an
option in the lower left corner of the Disk Drill window to filter such
volumes from view; this also applies to the Recovery HD, which is now
standard on all Macs since OS X Lion.

Aesthetics aside, Disk Drill should be considered an essential compo-
nent of any Mac owner’s utility belt. In addition to HFS+, the software
can also recover disks formatted with other file systems including
Windows NTFS or FAT and Linux, and built-in Self-Monitoring, Analysis,
and Reporting Technology (better known as SMART) will keep tabs on

your internal drive even when the application isn’t running. DISKDRILLALSO provides a

look at what’s consuming
BOTTOM LINE space on your drives,
. . . . . 5 . with the option to trash or
Disk Drill 2 is your first and last line of defense for dealing with misbe- permanently remove files or
having volumes on the Mac, and the Pro version easily pays for itself the folders no longer needed.

[ L ] Disk Drill PRO by CleverFiles

# B Macintosh HD

All files (no hidden & system ones) | over [OKB | | displayby | Space | view | default
Files & folders Occupied disk space v
» [ Users :
» [ Applications

» [l Library

¥ [ System
» [ Library ® 982
S... 0B

are ® 443.64 KB

» [r]..filtered ot

¥ I Incompatible
I: Avid CoreA

» (7).

437.49 K8

ilten

» [¥].. filtered objects...

Shown: 409.56 GB, filtered/hidden: 5.32 GB (reset filters) Help & support
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Disk Drill PRO by CleverFiles

E Upgrade your license g‘a Load scanning session c Resume last recovery

= Attach image

~ ﬁ :PPLE SSD SM512E T | - & Earea=
= E :aTlDSh HD - Logical Volume i Extras ~
- ﬁ 2a::im HD - WD My Passport 0748 Hacooor | = % Extras +
E Drobo mini - Drobo Mini - TB # Ext
0= ecover xtras
~ ﬁ Drobo 5D - Drobo 50 - 7B Recover | - # Extras -
oF
wsis  EFl It's @ system disk. We don't recommend messing
"] with It. vanage it at own risk, O
g —— WProtect | # Extras -
(- & View dala map
il Lsocatac Recover | - & Extras ~

Apply user-defined filter

first time trouble comes along. Aside from a Ul that feels out of step with
OS X El Capitan, my only caveat would be to hold off for the forthcoming
version 3.0 so your investment will last as long as possible, especially
when the Basic version offers sufficient peace of mind today without
breaking the bank. m

33

Selecting a whole disk or a specific partition is easier in Disk Drill 2

Help & support

DISKDRILL PRO 2 offers
comprehensive data
recovery for Mac, but nearly
two years after release, the
Ul is looking rather busy and
dated under OS X El Capitan.
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SOCIAL MEDIA

GRIDS FOR INSTAGRAM: VIEW
(BUT DON'T SHARE) SOCIAL
PHOTO FEEDS ON MAC

BY J.R. BOOKWALTER

CONSIDERING INSTAGRAM'’S BAKED-IN LIMITATIONS, it’s a

miracle the photo-centric social network has become as wildly GRIDS FOR

popular as it has. After all, third-party apps aren’t permitted to upload INSTAGRAM 311

images to the service at all, and nearly six years after the debut of ““5

the iPad, there’s still no tablet-optimized iOS update to be found. PRICE WHEN RATED
Instagram is also oddly walled off from desktop computers. Sure, §5

you can use a web browser to search or view images, but it feels like COMPANY

something the company grudgingly maintains. Even after Facebook ThinkTime Creations

acquired the service in 2012, Instagram remains stubbornly mobile-
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first, despite the efforts of developers like ThinkTime, who keep trying to
expand its reach.

INSTAGRAM FAUX MAC

Grids for Instagram (go.macworld.com/grids) puts more emphasis on
photos than user interface, and the result feels like a native Mac applica-
tion Facebook might have built if they chose to do so. Although it can’t
be used to actually upload photos from the Mac due to an API restric-

tion, Grids otherwise improves the Instagram experience in several ways.
First of all, there’s support for multiple accounts, and you can switch
between them in seconds with the click of a mouse. For years, Instagram  WITHSUPPORT FOR Retina

users have begged for this feature on smartphones, which comes in Displays and full-screen
mode, Grids makes
Instagram photos look their
as business use. There’s also a universal bookmark option for specific best on the Mac.

handy for those of us who depend upon the service for personal as well
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NOMATTER WHICH account

you happen to be using

at the moment, the Grids
bookmark feature can be
GRIDS FOR INSTAGRAM’S Brief view offers a nice compromise between visual eye candy and used as a shortcut to favorite
information about the photo. photos, users, or hashtags.

photos, users, or hashtags, so you can find them again quickly from
whatever account you happen to be signed into.

Grids can display content in four different layout styles: Square (image
only), Brief (image plus user details), Vertical (a close approximation of the
Instagram app with the description and tags displayed at the bottom), or
Horizontal (which relocates the description to the right side). | found Brief
to be a nice compromise between eye candy and information.

In all views, photos are displayed in a grid with no spacing in-
between, but users can adjust this for some breathing room via Prefer-
ences, with a white or black background. Grids supports full-screen
mode, which looks as great on a 27-inch Thunderbolt Display (go.
macworld.com/thunderbdisplay) as it does on my 15-inch MacBook Pro
with Retina Display.
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VIEW, DON'T SHARE
Clicking on an image (or pressing Return) opens in full-size photo view,
where you can read or leave comments. Unfortunately, Grids can’t
enlarge or otherwise resize in this expanded view; the zoom options in
the View menu are limited to the main timeline. This isn’t surprising
since Instagram doesn’t allow zooming on smartphones, although it's
technically possible, since third-party apps like Primary for iOS can do it.
Grids offers keyboard shortcuts for nearly every feature. Press the L
key or double-click to like a photo, C to comment, or scroll one page at
a time by pressing Page Up or Page Down (Shift-Space or Space will
also work). Some options are also available via contextual menu with a
Control-click action.
One thing Grids doesn’t do as well as it could is sharing photos: There
are options to copy or open a URL and save to disk (in full-resolution image fullsize, but there’s no
“HD,” if available), but there’s sadly no support for the OS X built-in share  4tion to zoom or otherwise
extension. Having recently launched a social networking campaign that enlarge from here.

PHOTO VIEW DISPLAYS an

& Ords File Edit View Layout Window Holp =] 2 T s Fin@2AM Qi
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GRIDS FOR INSTAGRAM
includes preference settings
for spacing, picture size, and
background in the main view.

Hide and show tooibar sutomatically Fuliscreen B

. Play videa sutomaticaly

g Petrosh Faed view automaticaly when new foss
s avaable

@ Fugioy 3 mosths ago
Hiat! 1 you are a over of rorih coast, you can also use our
1ag #expicengshoss for your photos of cokd sas nd sty
beaches'

4051 s | 75 comments

lonawhite
Ly

sunbesm i
DT

o smelyanova
310 TAK NpEXPACHD, STO K B DCTREARA THERY
Pmibcon, eCh 6 Tax WoRHG DR

esnhilikey
Low this!

required a lot of sharing to Facebook, this would have been a conve-
nient option to have.

Sharing aside, Grids is an otherwise faithful Mac port of the Instagram
experience, complete with conveniences like push notifications for new
activity, customizable views, and automatic feed refresh while the
application is open.

BOTTOM LINE

Aside from uploading and the lack of native OS X sharing, Grids delivers
an authentic Instagram experience on the Mac, and actually does it one
better with support for multiple accounts. B
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AIRTABLE: A DROP-DEAD
EASY RELATIONAL DATABASE
MANAGEMENT SYSTEM

BY WILLIAM PORTER

AIRTABLE IS AN ONLINE platform for creating, using, and sharing

small relational databases. It’s not ready for enterprise users yet AIRTABLE
(that’s coming), but right now, if you want help managing data for ““‘
personal use or for your small business, if you need to share that PRICE WHEN RATED
data with others, if you’d like users to access it anywhere, and if t"'%"ﬂ'vfee ranges from free
0 er user
you’d love to do all this for free (or next to nothing), then Airtable COMP[;NY
(airtable.com) might be the answer to your prayers. Aittable
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O House Hunter - MOBILE HELP [;L t_ﬁ
~ PROPERTIES A Hide columns <7 Add filters 1} Apply sort ‘ [Tj o00 C)\ @
% Address  |[Z1Rating -~ & Attachments. £ Price [=] Neighborhood
1 8547 Hillside Dr., Dallas, TX 75432 2 WE $650,000  Vista del Lago Lindo Est
2 41033 Pincus Cir, Dallas TX 75432 1 $462,000  Vista del Lago Lindo Est
3 3083 Garland Ln, Dallas TX 75440 1 - $519,000  Farm Ranch Meadows
+
3 rows ~ AVERAGE $546,667
On your computer, there is nothing to download. Just launch your THISIS MY simple house-
browser, go to Airtable.com, and sign up. It's free to get started. hunting base viewed ina

browser on a computer.

FIRST BASE: HOUSE HUNTING

You can pick from a couple dozen starter bases for different purposes.
(Base is Airtable-speak for database.) Or you can import a .csv file or
paste column and row data from an existing spreadsheet. But it's a snap
to build a base from scratch, so let’s do that. And since it’s easier to
show how this works with concrete examples, let’s do that, too.

Imagine you are in one city looking for a new house and your spouse,
having drawn the short straw, is back home packing. On your new
Airtable account’s home page, click New Base, give the base a name,
then double-click the base’s icon to open it. Three columns are pre-
defined for you: Name, Notes, and Attachments. The Name field in
Airtable is for a unique description of each row or record, so in this
scenario, you’d want to use the Name field for property addresses.
Define two or three more columns—Price, Neighborhood, Rating—and
you’re ready to go. All this takes, oh, 60 seconds.

One last thing. Before you hit the streets, download the Airtable app
to your iPhone and use the app to sign in to your new account. (There’s
an iPad app, too. An app for Android is in beta now and will be released
later this winter.)

SECOND BASE: ON THE PHONE
Now, when you are out visiting properties, you’ll launch the Airtable app

40
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on your phone, open the househunting base you created earlier, click on
an empty row, and enter each property’s address, price, etc. Click on the
Attachments column, then on the camera icon, and you can take one or
more photos of the property and they will automatically be stored in the
base. The app integrates well with your phone. If configured properly,
addresses can be opened in Maps; phone number values can be tapped

VIEW OF ASINGLE property
to make calls. There’s even a barcode column type so you can scan record in a house-hunting
barcodes. database. Clicking on the

camera button lets you take
a picture and store it directly
tired of typing the same neighborhood description again and again inside the base.

(“Vista del Lago Lindo Estates”). So in the
Record view, click on Customize Fields, then
click on Neighborhood and change its field
type to Single Select. Save your way out of the
base editor. Next time you create a new record,
when you click into the Neighborhood field, the
value picker will appear and you'll type in a
value only if it's not already there for the

Now if you visit many properties in the same area, you'll probably get

seec 0 Verizon F

picking.
Notice what is going on: You’re not only iy J =
entering data (including photos) on the iPhone, camera.jpg camera.jpg

you’re editing the structure of the database.
Need another column/field, say, Square Feet?
Click Customize again, and add a field. Or 3 PRICE
fields. On your iPhone. You could actually $659,000
create the base from scratch on your phone,
but that would be showing off.

And once you've shared your househunting
base, your spouse will now be able to take a
break from packing boxes, access the base,
review what you’ve seen, look at the photos,
and write encouraging notes to you in the = NOTES
Notes field. (“Are you kidding me? This place
looks like a dump!”) This data gets synced in
both directions instantly. (“Hey babe, take
another look at the price.”) If you wanted to
share with your teenager without giving the

] NEIGHBORHOOD

Vista del Lago Lindo Estates

Great neighborhood, house needs work

o Customize fields Il Delete record

a1
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teenager the ability to edit the base, you'd adjust Varizon = 3:04 PM
the access privileges for that share. Cuidtornizs Flelda
THIRD BASE: A FUNDRAISING BANQUET
You can even give access to people who don’t
have an Airtable account. For example, if you
were organizing a fundraising banquet, you could
create an RSVP form for your Airtable Invitees
base, publicize the url of the form, and let invitees
enter their own info (name, phone, attending or
not attending, number of guests, etc.).

As the RSVPs come in via the online form, Attachments
you’ll want to start assigning attendees to tables, oY Attachment
and Airtable can help here, too. Add a column to
your list of invitees and select Link to another
table, then create a new table and name it
Tables, as in “tables that guests will sit at”. Now
just click into that column to link attendees to
tables. Congratulations: You've created a rela-
tional database—er, base!

And you’d probably want at this point to take
advantage of a couple of Airtable’s calculation

) ) : Price
options. A roll-up column in the Tables view can (‘g) Cinrtency

keep track of how many guests have been
seated at each linked table, and a lookup column o Add a new field
in the Invitees view can mirror that total so you
can easily see whether there’s enough room left THE AIRTABLE APP for iPhone isn’t just for entering and viewing

data on the go, it’s powerful enough to create and edit base
structures. This screen is used to customize column data
types, add columns, etc.

at table 11 to seat Linda Lufkin’s party of five.

HOME RUN: DATA BASICS

Airtable may look like a spreadsheet but it isn’t. It's a database. Unlike
spreadsheets, databases require rigid data structures, so you will have
to think a little about how to organize your Airtable base. Will a column
be used for short bits of text like names or addresses or long text like
memos? Will a column be used for date values, numbers, currency? If
the data you’ll put into an Airtable base calls for two or more related
tables, you'll want to think carefully about how to link them.
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You’'ll also need to give some thought to how you want to view your

data. You can’t easily program or script Airtable but you can create
different views that filter (find) and display data in different ways. For
example, | built a to-do base and made different views that show me
only uncompleted tasks, or tasks to be done today, etc. Sound compli-
cated? It's not. There’s a lot of help available and live support is terrific.

And you can undo almost every action, so relax. If it can be done at all in

Airtable, it's usually pretty easy.

Airtable is easy partly because its developers have done a great job

of eliminating common relational database headaches. For example, you

never have to think
about the primary
or foreign keys
that link tables
together. But it’s
also easy because
it sticks to data
basics. The
scenarios or use
cases | described
earlier are, | think,
examples of where
Airtable shines.
Hunting for a
house or organiz-
ing a banquet, you
will appreciate
everywhere access
and the ability to
share your data. In
these scenarios,
you probably will
not need to worry
about complex
business rules
during data entry
(like “an order

O RF..Oom

RSVP e Jackson Elementary Gala

Let us know if you can attend the Jackson Elementary
Fundraising Gala on April 1 in the school gymnasium. We
hope you can come—and don't forget your checkbook!

Name(s)*

(Required) Your name and the name of any guest(s) who will
accompany you

Penny and Al Reinhart

How Many*

ed) Enter 1 if you're coming alone, 2 if you'll bring a date,

with friends who are RSVP
sut we'll do our best

Could we sit with Bill and Paula Forrester, please? (Paula is Penny's sister}

43
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online forms where anybody
with the URL can provide and
submit info. In this example,
the form is used to collect
RSVPs for a fundraising
banquet.
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e0e N .G @ 20160203 Airtable . % | [EJGALADAY - Airtable | # Formula field refere % [il] The Field Guide to | % William
& C | & hitps://airtable.com/tbI5BR0oa3tDNX1WF4/viw1SA9TvpFHTMVCY el = - B IO B S 0N =
Jd GALA DAY ~ MOBILE HELP Q

~ Main View | 11 hidden column | 7 Add filters 1, Apply sort

| & Name ~ | % How Many .- = Seating Request » =Table -- ES#Table -~ f:ERR -~ = Notes

1 Matt Donahue, Jessie Wells 2 1 7

2 liana Covetti 1 y | 7

3 Laura Lifton 5 2 8

4 Peter Koscy 1 2 8

5 Carlos & Connle Zepeda 2 2 8

6 Tom Tenebaum 5 3 10 | Table 3

7 Andy Gallagher, Tim Ross 2 3 10 !Table3

B8 Payne Bellinger + mom and d... 3 3 10 [Table3

9 Penny and Al Reinhart 2 Could we sit with Bill and Pau... 1 T

10 Bill Forrester et ux. 2 1 7
46 rows ~ BUM 112 v MINT

can’t be created unless an account exists and payment info has been AIRTABLE’S VARIOUS
entered”). If you're entering the data yourself, you also won’t have to EALCT"}AT“’I:F"'H'“”EB”
. . 0 alot. Inthis view, the
worry about minimum wage data-entry clerks making careless but costly user can see that Table
mistakes. And you probably won'’t care about beautifully formatted 3 (which seats 8) has too
printed reports. many people assigned.

BOTTOM LINE
Of course, there are other scenarios for which Airtable is not such a
good fit. | doubt Airtable is going to pull many users away from richer
database application development tools like FileMaker Pro. In FileMaker,
for example, a developer can write a script that finds uninvoiced line
items for a particular account, goes to another layout, sorts and totals
those line items, saves the whole thing as an attractively formatted PDF,
sends the PDF to the client via email, then comes back to the records
and archives them.

Now Airtable does have a fully documented API. Some benefits of the
API are easily accessible to Airtable users through third-party services.
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With a Zapier account (not free), you can get dated rows in your Airtable
base copied to Google Calendar (or integrate in other ways with a large
number of other online apps), and Slack can let you know when your
base is updated and help users sharing a base communicate. But using
the Airtable API to generate multi-step actions that resemble FileMaker
scripts will require programming, and it's a safe bet that most do-it-your-
self users of Airtable won’t go there. ALIBRARY DATABASE is

But even without programming, Airtable is amazing. Folks who, for shown with three linked
lack of a better option, have been throwing structured data into Excel or ?ubt:f:ci/:; t/:]?::’:’s;th:i,a?:;e
Google Sheets or (gasp) into tables in word processing apps, now have of relational database
the better option they lacked: they can put that data into Airtable, which ~ design, this would be
. L. . nearly impossible to doina
is an honest-to-goodness database tool. Factor in its cost and accessibil-

spreadsheet but was easy to
ity advantages, and to many users Airtable is going to be a revelation. put together in Airtable.

(D Biblioteca ~

- TITLES +Pub Info 01 hidden column | W Add fiters 1, Apptysort | (] | ase
@ TIMLE | EAuTHORS E subject E Notes [ Publisher i Yoar [=] Cover
1 Beauty in Photography | Adams, Robert Photography Aperture 1996  Paperback
Brutus | Cigaro, Marcus Tullius Classics ad H. Malcovati Teubner 1879 Hardeaver
3 Crypto: How the Code Rebels Beat the Gov.... [ Levy, Steven Technalogy Penguin 2001 Paperback
4 Dematrius on Style [ Roberts, W, Rhys Classics *The Greek Text of... Olms 1969  Hardcover
5 Fine Art Printing for Photographers | Guihins, Juergen  Steinmueller, L Photography 2nd edition Rocky Nook 2011 Paperback
B Grean Centuries Gordon, Caroling MNovel Cooper Square 1971 Hardcover
Hackers & Painters: Big Ideas from the Ca... : Graham, Paul Tachnalogy Oredlly 2004  Hardcover
L] Henri Cartier-Bresson | ‘Cartier-Brassan, Henri Fhotography Intro by Michael... Thames & Hudson 2006  Paperback
[} History of the Catholic Church: From the A. | Hitchcock, James Religion  History Ignatius Press 2012 Paperback
o Latin Metre: An Introduction I Raven, D.5. Classics Faber and Faber 1965  Hardcover
Laurus : Vodolazkin, Eugene Novel Kindie format ‘Oneworid 2015  Ebook
2 Life of a Photograph, The [ Abell, Sam Photography National Geograph... 2008  Hardcover
Light—Science & Magic ' Fuqua, Paul Biver, Steve Hunte - Photography 3rd edition Elsavier / Focal Press 2007  Paperback
4 Lost Lawyer, The [ Kronman, Anthony T. Law Harvard University ... 1908 Paperback
1% Magna Carta: Text and Commentary | Howard, AE. Dick Medieval Law History Univarsity of Virginia 1964 Paperback
& Mastering Regular Expressions | Friect, Jeftrey Programming 18t edition (1898; Tih...  O'Redly 1987  Paperback
| Metamorphoses. [ Ovid, (P, Ovidius Nasc) Classics ed, W.S, Anderson Teubnar 1988 Hardcover
B Napoleanic Wars, The [ Rothenberg, Gunthar £ History Smithsonian History Smitheonian/Colling 2006  Paperback
19 On History and Other Essays | ‘Oakeshott, Michaal Philosophy History Liberty Fund (India. .. 1999 Paperback
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What We're
Raving About
ThisMonth

ANKER POWERCORE+ 20100 §§##:

If you need a high-capacity battery that can fully charge a 12-inch
MacBook, the $50 Anker PowerCore+ 20100 (anker.com) is your
best bet. It's far cheaper (especially adjusted for inflation) than
what a removable replacement used to cost when Mac laptops
offered swappable batteries. Plus, it performed well in our tests,

has an attractive shape and material that fits nicely in the hand,
and features a perfectly-adequate three ports, including a
combined in/out USB-C charging port. —~GLENN FLEISHMAN

46


http://www.softgozar.com

TALENTCELL 10400MAH 38WH
PORTABLE CHARGER §###

The $27 Talentcell 10400mAh 38Wh

Portable Charger (talentcell.com)

is sturdy and well

snapped together, and

performed extremely =
well in testing. While it

ostensibly has just ~ @
10,400 mAh of capacity, \

in testing it seemed to L \
punch well above its

class. It was able to recharge a

MacBook to 80 percent (as reported

by OS X) before the juice stopped flowing.
However, it caps input at 1.5A, making it take
nearly as long to charge as a pack with twice the
capacity. —GLENN FLEISHMAN
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Hot Stuff

RAVPOWER 20100MAH

EXTERNAL BATTERY PACK ###!

The $56 RAVPower 20100mAh External Battery Pack (ravpower.com) only
charged my 12-inch MacBook up to 90 percent before it was exhausted.
However, if you need speed and diversity of ports, and you have the right
mobile equipment to go with it, you might actually prefer the RAVPower to
other models. It can be recharged through two ports (Micro-USB and USB-C),
and the USB-C port can also charge other

devices. And it has two Type-A ports

with distinct characteristics.

—GLENN FLEISHMAN
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The Latest on the iPhone, iPad,
iPod Touch, and App Store

L R
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Why you should use your iPhone

with a Bluetooth keyboard as
your main travel computer

It's not as crazy as it sounds.

BY CHRISTOPHER PHIN
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ith all the unsettling, unblinking zeal of a mission-
ary, | want to try to convince you that something
which sounds a bit weird is actually a great idea
that will completely change your life. | want you to

consider using an iPhone as your primary computer when you're
traveling, especially on business, only carrying one extra thing

with you: a Bluetooth keyboard.

Let me admit up front that you will
look a bit peculiar. As you board a
train, as you check into a hotel, as
you post up at a coffee shop—if all
you’re carrying is a keyboard, you will
attract looks. You could, naturally,
carry a bag instead and stash the
keyboard in it, but while this makes
you look less goggle-eyed crazy, it

takes away from one of the main
advantages of the iPhone-plus-key-
board setup: traveling light.

Why bother with the keyboard at
all? Well, of course, for most of us, we
can type faster, more accurately, and
more comfortably on a familiar
full-sized keyboard than if we're
pecking away on an iPhone’s screen.

THEKEYBOARD |
personally tend to use
with my iPhone is an
ancient model from
Think Outside.



http://www.softgozar.com

iOS CENTRAL

iPHONE AS A TRAVEL COMPUTER

And why not just use an iPad with its
bigger, soft keyboard, or indeed a
laptop? Because you don’t need
them! You probably have your iPhone
with you at all times anyway, so if you
can then why not use it rather than
giving yourself the physical and
logistical baggage of carrying
another device?

And an iPhone is an astonishingly
useful and capable work device. It's
always connected (unlike your
MacBook), and with a little planning
and exploitation of cloud services
(unless you have very specific needs)
it's likely that you can do far more

Coft oXar.oom

work on an iPhone, and far more eas-
ily, than you might assume.

Indeed, for many of us, the one
thing that stops us doing big bouts of
focused work on an iPhone—whether
that’s writing emails, working on
documents, even just keeping in
touch with the office or friends
through iMessage—is that it can be
tiresome to write much more than a
few tweets on its onscreen keyboard.
Hence the Bluetooth keyboard—and
| promise you that the first time you
try this, as well as feeling a bit
conspicuous, you'll be amazed at
how productive you’ll be on the go.
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PICK YOUR KEYBOARD
Let’s start with some shopping. If you
don’t already have a Bluetooth key-
board, you'll need to pick one, and |
have some suggestions. (If you do
already have one, great, but just note
that unless it's one that’s designed to
be paired to multiple devices, and you
don’tintend to use it full-time with your
iPhone, then it will be a bit of a faff as
your iPhone and your Mac, say, fight
over which of them the keyboard is
connected to.)

The keyboard | personally tend to
use with my iPhone is an ancient
model from Think Outside.

I love it because it folds in half, so
I'm not walking around with a key-
board like some twenty-first century
equivalent of the wandering trouba-
dour; | love it because the keys feel
genuinely amazing; and | love it
because it’s just powered by a couple
of AAAs, so | can pick up a pair of
batteries from basically anywhere if |
run out of juice. Plus, it has a handy,
detachable stand that can hold my
iPhone at two angles.

Yeah, it was designed for Pocket PC
and Windows Mobile devices, so some
of the keys are in weird places or
serve no purpose, but it's a small price
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to pay for such a compact, handy
keyboard. The catch is that while you
can still buy it today, the few remaining
new units (go.macworld.com/think
outside) will set you back nearly $190,
but you could go second-hand and
save money.

But, of course, you could go for a
more modern and less fussy keyboard.
The other one | especially like is the
K811 from Logitech (go.macworld.com/
k811), which has great-feeling backlit
keys, and can pair with three devices—
for me, that means my iPhone, my
iPad, and my Mac.

The current equivalent of that in
Logitech’s lineup is the K380 (go.
macworld.com/k380), but you might
also consider the K480 (go.macworld.
com/k480), which has a little gutter
behind the keys in which you can
prop up a smartphone or tablet. Or,
of course, you can go for the familiar-
ity of one of Apple’s aluminum
keyboards.

There is another option: Although
rarely seen (mostly because with some
justification manufacturers think it will
only appeal to education buyers), there
are keyboards from the likes of Belkin
(go.macworld.com/B2B124), Griffin
(go.macworld.com/XB38326), and
Kensington (go.macworld.com/
k72447ww) that connect not over
Bluetooth but via the Lightning or
30-pin port on the bottom of your
iPhone. While the cable is a little untidy,

Coft oXar.oom

iPHONE AS A TRAVEL COMPUTER

it means you don’t even have to worry
about charging your keyboard, since it
draws power from the iPhone.
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STAND UP!

So, you've got your keyboard—now
you probably want to prop your
iPhone up. If you're working on a
plane or train with a seat-back tray in
front of you, it’s likely that the grippi-
ness of a silicone case from, say,
Apple, is enough to stop it from sliding
flat if you prop it up leaning against
the back of the seat in front of you.

If not, something like a Glif (studio
neat.com/products/glif) is handy and
can be attached to your keychain so
you always have it with you.

Indeed, basically any other stand
you might have handy will work, such
as the Compass by Twelve South
(below), which, while technically
designed for iPads, can be pressed
into service for an iPhone.

THIS ONEIS the original
Compass, but Twelve
South has moved on to
the Compass 2 now.

HEAD IN THE CLOUDS

You're all set! All you need to do now
before you head out the door is
make sure you’ll be able to access
any stuff you’ll need to work on as
you travel. Usually, this means
ensuring documents are stored in
the cloud—Dropbox or iCloud, most
commonly—but it might mean
dropping stuff across to your iPhone
via iTunes for some older apps.

One final recommendation: If
you’re going to be working a lot on
your iPhone on the go, you’ll quickly
burn through the battery. Consider a
battery case, such as one of
Mophie’s Juice Packs or Apple’s
Smart Battery Case.

Converted? Go forth and prosper! m
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Howa

Pro model
could
change
the iPhone

Mac Pro, MacBook Pro, iPad
Pro..what about an iPhone Pro?

BY MICHAEL SIMON
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ack in May 1998, Apple hyped an upcoming special
event in three words: Pro. Go. Whoa. After Steve Jobs
had finished his keynote, it was clear what they
meant: Pro was for the Power Macintosh G3, Go was

for new PowerBooks, and Whoa appropriately captured the
reaction to Apple’s newest computer, the iMac.

It wasn’t just a clever marketing
slogan. For the first time, Apple made
a clear distinction between consum-
ers and professionals. The Power Mac
and iMac may have both used G3
processors but they were marketed to
different audiences; the beige tower
was for users who craved speed and
expandability, and the translucent
iMac was for everybody else.

Nearly 20 years later, all of
Apple’s computing lines have a pro
delineation, with one notable
exception: the iPhone. The Mac Pro,
MacBook Pro, and iPad Pro are
obvious upgrades to their second-
tier counterparts, but the iPhone line
serves no such distinction. Even
when it introduced two sizes with
the iPhone 6, Apple opted for the
Plus surname instead of Pro, sepa-
rating the models by size rather than
performance.

But | think that may be about to
change.

BREAKING AWAY
Despite Apple marketing them
merely as larger phones, the iPhone

Coft oXar.oom

6 Plus and 6s Plus are positioned
much in the same way as Apple’s
other pro products. Where Sam-
sung’s Note actually has a lower ppi
density than the Galaxy S6, Apple
gave the iPhone 6
Plus a 401ppi
1920x1080
display,
making it
the first
iPhone to

have a screen
density higher
than the 326ppi
retina standard. The
Plus also got a larger
battery, an iPad-like
rotating home screen, and
a camera with optical image
stabilization.

But where other phablets
are packed with extra RAM,
smart stylus support, and other
tablet-esque features, the iPhone
Plus doesn’t act much like an iPad at
all. The difference between it and
the standard iPhone 6 boils down to
little more than a matter of prefer-
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ence. The battery and camera
advantages are nice, but anyone
who decided to buy one more than
likely did so solely on the basis of the
screen size.

And that’s where Apple could
shake things up with the iPhone 7—if
that’s even what it’ll be called.

HEIR TO THE AIR

To say Apple has a lot riding on this
year’s iPhone is an understatement.
Not only have sales plateaued, but
for the first time Apple doesn’t have
any real expectations to ride. Every
non-S iPhone release has brought a
major feature users had to have—3G,
retina display, larger screens—but
the next iPhone’s flagship feature is

less obvious.

By this time we usually have a
pretty decent picture of what the
next iPhone will look like, but the
most persistent rumor we’ve heard
(go.macworld.com/7iphonerumors)
so far is that Apple is doing away
with the headphone jack (go.mac
world.com/hponejackrumor). That
could push the next inevitable major
change—the removal of the home
(go.macworld.com/nohomebutton)
button—out at least one more
revision. Since the new iPhones are
expected to retain the same screen
sizes, any major improvements will
need to come from the inside.

Things like battery life and wire-
less charging are certainly on the
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table, but | think the new iPhone
might be something of an iPad Air—
style reboot rather than the usual
redesign. And as we approach the
first revision of the Plus, Apple has a
chance to separate it further from the
smaller model—perhaps even give it
a new name. Calling the new phones
iPhone Air (4.7 inches) and iPhone
Pro (5.5) would accomplish two
things: It would position the larger
iPhone as more than just a larger
iPhone, and it would allow Apple to
abandon its naming scheme (or at
least reset it) before it starts getting
too clunky.

FEATURE PRESENTATION
Sitting next to the iPad Air, the iPad
Pro seems just like the iPhone Plus:
a model for people who want a
bigger screen. But as with the Mac,
it's not the size that makes it pro,
it's the capabilities, from the Smart
Connector to the Pencil support.
With its smart speaker system and
A9X processor, the iPad Prois a
beast of a tablet, much closer to
the performance of a MacBook than
the iPad Air.

It's not too much of a stretch to
imagine an iPhone Pro that bridges a
similar gap between phone and
tablet with a smattering of features
exclusive to the 5.5-inch model.
There have already been rumors of a
256GB Plus model and a dynamic

dual-cam-
era system,

but Apple

could take even
further by embracing
the productivity and
power benefits of its largest

iPhone.

Aside from a faster processor and
extra RAM, the most obvious addi-
tion would be a smaller Apple Pencil
geared for note-taking and other
light tasks. Samsung’s S Pen is one
of the main differentiators between
the Note and Galaxy S lines, and |
could see Apple selling one as an
accessory for Notes (which is poised
to get even better with iOS 9.3), as
well as a navigation aid.

But while an iPhone Pro would be
the ultimate handheld device, the
idea that Apple is going to keep all
of this power confined to our pock-
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ets seems silly. If the iPhone is going
to stay at its current size for a few
revisions, | think Apple will find more
ways to use it as a hub.

EXPANSION PROJECT

Each of Apple’s Pro devices is
anchored by a greater level of
expansion: Thunderbolt, the iPad
Pro’s Smart Connector. But it’s hard
to imagine Apple adding another
port to the iPhone—even a magnetic
one. But through Wi-Fi and Bluetooth
4, Apple could let the iPhone operate
both independently and as part of a
seamless larger system.

Recently HP showed off its Mobile
Extender, essentially a touch-based
laptop that comes to life when the
Elite x3 phone is within range. It’s an
interesting concept for an iPhone
Pro—not a hybrid per se, but a way
to maximize productivity based on
location. When you're on the go it’s a
fully capable phablet, but at a desk it

lets you work with a keyboard and a
full-size screen, without having to
sync data or hand off tasks (go.
macworld.com/handoffandcont)
between devices.

And Apple could soup up iOS as
well. It's already shown how well it
can specialize features with iOS 9’s
iPad multitasking (go.macworld.com/
ios9multitask) and the iPhone Plus’s
landscape home screen. Drawing a
line between an iPhone Air and the
iPhone Pro presents interesting
possibilities for navigation and
productivity, like a version of the
iPad’s Slide Over or keyboard
Shortcut Bar, or borrowing the Smart
Lock feature from Android.

But no matter how it goes about it,
| think the sixth major iPhone revision
will represent a monumental shift for
Apple’s most important product.
Maybe even big enough to make us
all go “Whoa” again. m
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Hands-on: LifePrint AR printer
lets you share GIFs, Live Photos
and Vines in real life

LifePrint creates photos equipped with augmented reality that can be shared
remotely via its connected printers.

BY OSCAR RAYMUNDO

oft orar.com
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our Instagram videos are getting the augmented
reality treatment thanks to a new mobile printer.

The LifePrint (lifeprintphotos.com) can print instant
photos directly from your iPhone, Android phone, or
GoPro via Bluetooth. It uses Zink film and its thermal printing
technology so it doesn’t require ink or toner. In that way, LifePrint
is very much like the Polaroid Zip Instant Mobile Printer (go.mac
world.com/polaroidzip). In fact, the two printers are nearly the
same price: the LifePrint is $129 and the Polaroid Zip is $129.95.
But the LifePrint can print Apple Live Photos, GIFs, Vines, Insta-
gram videos, and GoPro clips. And you can use the LifePrint app
to see how these printed images move, loop, and rewind.

The LifePrint app for iOS and Twitter) so you can quickly select
Android connects to your camera roll  which image you’d like to send to
and social media accounts (Face- the printer. If you want to print a

book, Vine, Instagram, YouTube, and video or a moving image—like a Vine

@

VIDEO

To view this video,
goto go.
macworld.com/
lifeprint
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LIFEPRINT AR PRINTER

or Live Photo—then you get to select
the exact still frame you’d like to have
printed. Moving images that get
printed as still photos are referred to
as HyperPhotos. You can use the
LifePrint app’s augmented reality
viewfinder to bring these HyperPho-
tos back to life.

Here’s how it works: When the
LifePrint prints a HyperPhoto, it adds
a special code to the picture that’s
not visible to the eye. Meanwhile, the
LifePrint app uploads the associated
raw image file to the LifePrint cloud.
When you want to view the moving
photo, the app uses photo recogni-
tion technology to pick up the
invisible code and matches it to the

raw file of the moving image. The
app then pulls up the raw file from
the LifePrint cloud and plays it
instantly, along with any audio. You
can watch the video on the previous
page to get a better idea of how
LifePrint works.

The LifePrint takes about 30
seconds to print a picture, whether
it's a regular still image or a Hyper-
Photo. The printer takes about an
hour to charge and you can print up
to 15 photos on a full charge. Even
though you won’t need to refill it with
ink nor toner, Zink film costs about
50 cents per photo.

You can pre-order LifePrint now for
$129 and get it shipped to you in
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August. After initially raising over
$200,000 on Kickstarter, the LifePrint
team is now using Indiegogo as a
pre-sale platform.

AR PHOTOS ARE THE NEXT
SOCIAL SURPRISE

In addition to including an invisible
code, the LifePrint also adds a
watermark to the corner of your
HyperPhoto so you can tell which
images are equipped with this
augmented reality technology.
There’s also an option to remove the
watermark altogether.

The LifePrint doesn’t require that
you print a still frame taken directly
from the moving image if you want to
create a HyperPhoto. In fact, the still
frame and moving image can be

completely unrelated so you can pull
off an amusing bait-and-switch. For
example, you could print a still photo
of a sexy model that would play a
clip of Rick Astley singing “Never
Gonna Give You Up.” Think of it as
“rickrolling,” augmented reality style.
HyperPhoto clips can last up to 15
seconds, the length of an Instagram
video. However the LifePrint team is
hoping to increase the length to two
minutes so in the future you might be
able to watch an entire music video

or movie trailer by viewing a Hyper-
Photo with the LifePrint app.

In the future, the LifePrint team
also hopes to bring this AR photo-
viewing capability to the masses.
LifePrint-made movie billboards, for
example, would play an exclusive
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movie clip, and pop stars might want You can even send a photo to all

to send photos to their fans that play your friends at once. Your friends will
their latest music video. Bringing QR then get a notification on the Life-
code-scanning to a more visual realm Print app where they can choose to
is something other mobile companies print the photo

are starting to tap into. Last month, or ignore it. If [_ T
song recognition app Shazam part- they choose to THE LIFEPRINT APP
nered with RCA Records (go.mac- have the photo ALSO HAS YOUR
world.com/rcashazam) to send music printed, they STANDARD SOCIAL
fans a postcard of their favorite artist. can go back to FEATURES: ADDING
These fans were then able to use the the app to add FR|ENDS, LIKING
Shazam app to view the postcard and  a digital “like” PHOTOS, AND
unlock an exclusive song. or comment. POSTING COMMENTS. ‘
The LifePrint —
CONNECTED PRINTERS DO team is hoping
PHOTO-SHARING IRL that social media stars and celebri-
AR technology is not the only thing ties with a lot of followers might want
that differentiates the LifePrint from to mass-send a HyperPhoto to all
the Polaroid Zip. The LifePrint app their fans with a LifePrint printer to
also has your standard social fea- unlock promotional content, similar
tures: adding friends, liking photos, to the Shazam and RCA Records
and posting comments. But with the stunt.
LifePrint, you can do photo-sharing in For normal folks, LifePrint’s
real life and even remotely. connected printer network might also
Once your friends pair their be a fun way to send party invites,
LifePrint printer to their LifePrint greeting cards, or family holiday
profile, you can use the app to send pictures. Of course, this relies on all
them a photo to have printed of your friends having a LifePrint
remotely on their LifePrint printer. printer at home. B
66
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This is how you say
it’s going to be okay.

Every 8 minutes the American

Red Cross responds to a disaster
and makes this promise. This holiday
season, you can help us keep it.

American Red Cross
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CONNECTED HOME
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ELGATO EVE CONNECTED-HOME SYSTEM:
ELEGANT DESIGN AND OPERATION WITH
HOMEKIT COMPATIBILITY

BY JON L. JACOBI

IF ELGATO’S HOMEKIT (elgato.com/eve) kit products aren’t an homage
to the movie Wall-E, I'll eat my hat. It would be a baseball hat, and my
least favorite, but | don’t think | have to worry. Look at the image above.
Even if the company claims otherwise.
If you don’t know what the heck I'm talking about, Elgato’s environ-
mental and door/window sensors and its remote on/off switch are styled
much like EVE, the robotic love interest in the animated Pixar movie;

Coft oXar.oom
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they’re clean and glossy white with just a hint of green. Okay, there’s blue

in the movie as well and the green flashes, but...then, of course, there’s ELGATO EVE DOOR
the name. It's all-caps in the movie, but those are about the only things & WINDOW
that aren’t note-for-note. I'm dishing out compliments here. They look ‘t“
nice, and unobtrusive in my largely white-walled rooms and hallways. PRICE

Elgato sent me all four devices in the kit: the $50 Eve Energy, a smart $40.00
power receptacle; the $40 Eve Door & Window, which is a door/window ELGATO EVE
sensor; the $80 Eve Room, which tells you the temperature, humidity, ROOM
and air quality of any space; and the $50 Eve Weather, which does “‘%
largely the same thing outdoors (with the exception of barometric PRICE
readings replacing the air-quality function). Missing from Elgato’s con- $80.00
nected-home collection is a motion sensor (the company does offer a ELGATO EVE
smart LED light bulb, which is not part of this review). ‘:;A;;ER
HOMEKIT AND AUTO-MAGICAL, PRICE
TRANSPARENT FRUSTRATION $50.00
First a little on HomeKit, Apple’s connected-home technology. HomeKit ELGATO EVE
devices can be controlled by iOS apps connecting directly with them via ENERGY
Bluetooth and/or Wi-Fi if you're nearby, or your iCloud account when ‘t%
you're out and about. Remote access should “just work” once you’ve PRICE
entered the device code into you iCloud keychain. More on that in a bit. $50.00

Elgato’s products use Bluetooth, probably because it’s far less power- COMPANY

Elgato

hungry than Wi-Fi. The only issues there are that it limits the range of
communications to about 25 feet and requires
a bridge to reach the Internet.
Via Bluetooth, when | was within the range of
the devices, everything was hunky-dory. The
nicely rendered Elgato app gathered all the
pertinent information, and | was pleased to note
that the air quality inside my house was consid-
erably better than | had thought it was.
Elgato thoughtfully loaned me an Apple TV

to serve as a Bluetooth hub and to relay the
device readings to iCloud. This is where | ran
into problems.

For me, “just work” meant several days of
sign-ons, sign-offs, resets, reboots, iCloud

THEEVEDOOR & WINDOW lets
you know the status of your
egresses.
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keychain enables/disables, reinstalls, and

so on before | got remote access to

function correctly. What appeared to fix

things was signing off one of the iPads

from iCloud. On the other hand, there was

another Apple TV nearby. | never did learn

the exact cause, because Apple veils

connection and status information so that

HomeKit seems “magical” and “transpar- |
ent.” It also makes troubleshooting difficult }
in the extreme. The Apple TV doesn’t

show you what’s connected to it, and GVE '
there’s zero info about HomeKit communi- /
cations on the iCloud website. In the end,

it all worked, even if | don’t know why it | & 0 i [ @

didn’t to begin with. o N '
Temperature Humidity Air Pressure

Even when everything is working, you
must still have all the Eve devices within
25 feet of the Apple TV, which could be tough depending on the size ELGATO’S EVE WEATHER is
of your abode and the location of your TV. The Apple TV can’t be an outdoor barometer,

. . . . thermometer, and
allowed to sleep if you want it to relay things to iCloud. There are hygrometer (humidity)

third-party repeaters in the works, and to me, HomeKit won’t be a sensor.
universally viable connected-home solution until they arrive.

IN DEPTH

The Eve Door & Window sensor, which tells you whether a door or
window is open or closed, is a two-piece device with one half residing
on the door or window frame and the other on the door/window itself, |
thought | might have problems mounting these on my rather ornate
woodwork, but | didn’t.

In fact, it was easy and the two parts aligned without my having to
use the provided spacers. One thing | didn’t mention is that it tracks
the number of times the ingress/egress has been accessed. | guess
that might let you know that you need to get outside more. Or stay at
home more. Elgato says the Door & Window will run for approximately
a year on its single half-length AA battery.

The Eve Room environmental sensor is an approximately 3.0-inch
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square, 1.25-inch thick cube that runs for three months on three AA
batteries. It measures the air quality (in parts per million) as well as the
temperature and humidity. | actually found this handy when trying to
figure out if there was second-hand smoke drifting into my apartment
from downstairs. (It turned out to be someone with a malfunctioning
chimney nearby.)

Then there was the Eve Weather, another white flattened cube of the
almost same dimensions as the Eve Room, requiring only two AA
batteries to run four times as long—about a year. It measures humidity,

THEEVEiOS app having just
air pressure, and temperature and is designed for outdoor use. | guess pp o)

updated via iCloud. Notice

testing air quality is power intensive. Ilts measurements jived quite well that Bluetooth is off.
iPad = 10:00 AM 77%
£ At a Glance

BACK STAIRS

FRONT DOOR

HALLWAY

OFFICE

B
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with my other instruments, and it has the
mounting recess which is for some reason
absent on the Eve Room. (I mounted the
Room with double-sided tape)

The Eve Energy, a three-prong single-
outlet power adapter functioned perfectly
as well. But it serves only as an on/off
switch (it cannot dim a light) and energy
meter, and there currently is no schedul-
ing mechanism, though | was told one is
planned. The Eve Energy doesn’t require
a battery because it plugs into an AC
outlet. —

The Eve app can break down informa-

tion along a graph. Other than that, it ,@ & ‘ O }
basically shows you what the sensors are == S I
reading and lets you turn the Eve Power Air Quality Temperature Humidity
on and off.
THEEVEROOM is an indoor environmental sensor.

CONCLUSION
| didn’t really think I'd use the Eve products much, but they were surpris-
ingly handy. I could tell if my roommate had walked the dogs with the
Eve Door, whether it was raining or likely to with the Eve Weather, and |
already mentioned accumulating evidence of second-hand smoke with
the Room. Once it was working, the Eve system proved useful, but not
life-changing.

There are software features yet to come, but I'm giving all four Elegato
products my seal of approval as is. That said, the actual ratings on page
69 reflect their current state of usefulness. m
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PHOTOGRAPHY APPS

PHOTOWALLH+:
EVERY iOS
DEVICE CAN
BE THE LIFE
OF THIS APPLE
TV PARTY

BY J.R. BOOKWALTER

PARTIES AND EVENTS take
forever to plan and organize, only
to be over in the blink of an eye.
Once everyone leaves, photos
taken on their smartphones go
with them. As host, you're left
with only memories and a mess
to clean up should guests forget
to share their pictures—and even if they do, it could be days or weeks later.

It doesn’t have to be this way: Assuming you own the latest Apple TV PHOTOWALL+1.2
and your partygoers have iOS devices, you can not only gather all of the ““
photos being taken as they happen, but make those images part of the
actual event itself. 10

Built upon the company’s mobile-only Partysnapper app, Boinx ““
Software touts PhotoWall+ (boinx.com/connect/photowallplus) as “a
social photo wall for Apple TV” that could very well become the life of
your next party.

PHOTOWALL+ CAM

COMPANY

Boinx Software

WHERE’S THE PARTY?

PhotoWall+ is an app for the fourth-generation Apple TV that works in
tandem with a free, universal companion app for the iPhone, iPad, or
iPod touch called PhotoWall+ Cam (go.macworld.com/photowallcam).
After creating a new photo wall (or opening an existing one) on the
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Product Launch Reception Office Party Wedding Reception

Apple TV, iOS devices will be able to add new or existing images to the
television screen for all to see.

Aside from getting everyone on the same Wi-Fi network, there’s
literally zero configuration. Open the PhotoWall+ Cam app on your
mobile device, snap a picture using front or rear cameras (with optional
flash), then select a hosted event. (If PhotoWall+ isn’t running, the Cam
app displays Find Host instead.) Now tap Send, and within seconds the
image appears on-screen, then begins cycling through a slideshow of
everything added to the event thus far.

While the slideshow is active, the Siri remote can be used to control
playback. Play/Pause freezes the current photo until you press it again
to resume, while the Menu button is used to exit. Sliding your thumb left
or right across the Touch surface jumps to the previous or next slide,
while up and down controls playback speed.

Participants aren’t limited strictly to shots taken on their own devices.
Anything in your photo library is fair game. By default, new photos are
saved in each guest’s respective Camera Roll, but this can be turned off

in the Cam app. Worth noting: Guests can only send one photo at a time,

and there’s no support for videos.

SAY CHEESE!

PhotoWall+ can be used even at venues without an active Internet
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PHOTOWALL+ CAN CREATE
photo walls for any event,
syncing them via iCloud
SO you won’t miss a single
moment.
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connection. All that’s required is a wireless router, such as an AirPort
Express or AirPort Extreme. Wi-Fi is used to push full-resolution images to
the Apple TV, and the images are temporarily saved on its internal storage.
Once the device is reconnected to a wired or wireless Internet connection
back home, shared images are backed up to your iCloud account.

That’s where things get interesting, because Boinx has created a web
app so PhotoWall+ users can log in with their iCloud credentials and
browse or download images shared by guest photographers. (For those
like me who keep separate accounts for iCloud and iTunes/App Store
purchases, you'll log in with the former.) JPEG files can be downloaded
individually from Safari, but doing them all at once requires Google
Chrome.

Hosts can also change the transition style of the current photo wall by
pressing firmly on the Touch surface of the Siri remote and selecting
from the available options: Fade, Ken Burns, Latest Image, Spring, or
Stream. (This also works with the older aluminum remote by holding
down the center button on the directional pad.) The remote can also be
used to selectively hide or delete individual photos.

THE FREE COMPANION
PhotoWall+ Cam app is all
your iPhone-, iPad-, or iPod
touch—loving guests need to
joinin the fun.
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PhotoWall+ works just as seamlessly as it sounds, and it's a whole lot WHEN THE PARTY’S over, the

of fun to use. There’s really only one downside, and that's the lack of a host can loginto a web app

. . . , with their iCloud credentials
companion app for Android or Windows Phone. Unless you’ve sur-

to download everything
rounded yourself with friends who share the same good taste in Apple shared by guests.

products, someone’s bound to be left out of the party. There’s also no
way to directly share photos from the web app, which feels like a missed
opportunity.

BOTTOM LINE

PhotoWall+ is a great way to liven up any party, event, or family fun night,
requiring no technical savvy or fiddly settings to use. The only thing
missing is support for mobile platforms not named after a fruit, which
would allow everyone to join in the fun. m
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What'snew
at the App Store

2016 ELECTION
CENTRAL

Nate Ashworth, a self-proclaimed
hobbyist who claims he’s “not spon-
sored by any candidate, PAC or any
other election-related entity.” He’s just
a guy who really likes covering
campaigns. His “hobby,” has yielded
an extremely robust 2016 Election
Central (go.macworld.com/2016
ElectionCentral) app, not typically
found elsewhere: 2016 primary
schedules and delegate counts, party
debate schedules (and info on getting
tickets!), election-related videos and a
stream of Nate-authored posts
disguised as a newsfeed.

77

270toWin

270 270toWin (go.macworld.com/

270towin) aims to educate while it
EW'N informs. This app brings the Electoral

College to colorful life across a variety
of U.S. maps. The Library supplies electoral
templates from the last three presidential elec-
tions, any of which you can use as the basis for
creating your own, custom map. This is where you
can channel your inner Nate Silver and try to

predict this year’s outcome, or just track the
results on election night.

RealClearPolitics

The idea behind RealClearPolitics
(go.macworld.com/RealClearPolitics)
(the app offshoot of “the most visited
political website”) is to provide
curated non-partisan coverage of all the issues. It's
not specifically an election-oriented app, though
obviously a lot of the current news falls into that
bucket. It’s a pretty basic, plain app, with an
omnipresent ad banner across the top. But if you
want a simple political-news aggregator that at
least promises balanced coverage, this is it.

U.S. Election 2016 News

Election NF 2016 (go.macworld.com/
uselection2016)—U.S. Presidential
2016 : . )
Elections News is all about election
out o
news, presented here in a straightfor-
ward, nicely designed scrolling feed. The app
provides one-tap access to poll data from Politico,
complete with search and filtering options. You can
customize the news feed to block any unwanted
party or person, getting exactly the election
coverage you want. Just be prepared for the
occasional pop-up and interstitial ad.—RICK BROIDA
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Carry-all options for commuting

This month’s roundup of iPad bags brings you new “weekender” style briefcases
from HEX and MacCase, and plenty of carry-all options for commuting.

BY EMANUELA CORSO AND MARCO TABINI

TOFFEE

The Centennial Backpack, all iPad models and
iPad Pro are $137; toffeecases.com) sports a
water-resistant exterior made with waxed canvas
and finished with leather. The backpack includes
a zippered main compartment with a dedicated
padded pocket for your iPad and laptop, as well
as a generous amount of additional room for all
your accessories. It comes with both adjustable
shoulder straps and leather handles.

MACCASE

The Premium Briefcase (iPad Pro; $249.95 to
$279.95; mac-case.com) features a dedicated main
compartment for your iPad Pro and many smaller
pockets for everything else you need when you're
out and about. Available in “vintage” (pictured here)
or black, the briefcase comes with an Apple Pencil
holder, an optional shoulder strap, and a padded
interior lined with poly-suede for a smashing look.
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SPIGEN

The Klasden 3 (all iPad models and iPad Pro;
$100; spigen.com) is a modern-looking
backpack that doesn’t skimp on functionality.
It's compact, durable, and weather-resistant.
Available in gray or black, the Klasden 3
features a synthetic fur-lined sleeve for your
iPad, several zippered and open pockets for
your accessories, and padded shoulder straps
for a comfortable fit.

GRIFFIN

To make your commute easier, the Survivor
Briefcase (all iPad models and iPad Pro; $190;
griffintechnology.com)gives you plenty of
padded room for your iPad, MacBook, and
iPhone. This weatherproof briefcase has been
tested to withstand drops from up to six feet,
sports a sealed zipper to keep out excess
moisture, and comes with a number of
compartments to neatly organize all your
belongings. The Survivor also features a
removable shoulder strap and a handle, and
its velcro back pad slips let you easily attach
the bag to a luggage handle.
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HEX

The Calibre Black Sneaker Duffel (all iPad
models and iPad Pro; $159.95; shophex.
com) is a duffel bag tailor-made for all your
high-tech equipment. Finished with a
water-resistant coating, the bag includes
afaux-fur lined main compartment for your
iPad, two side pockets for your sneakers,
and a detachable shoulder strap for
hands-free carrying.

PAD & QUILL

The Roll Top Backpack (all iPad
models and iPad Pro; $319;

) protects your iPad in
style with gorgeous rich leather,
hand-pounded copper rivets, and
parachute-grade nylon stitching. The
backpack features a dedicated
compartment for your iPad, a zippered
internal pocket to secure your
valuables, and plenty of room for a
water bottle, books, and other daily
necessities. Available with adjustable
shoulder straps for a comfortable fit, it
comes in Chestnut, Chocolate,
Galloper Black, or Whiskey.
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oth the Oculus Rift (go.macworld.com/oculus-

preorder) and HTC Vive (go.macworld.com/

htcvivepreorder) headsets will soon be

released to the public, finally delivering on the
long-envisioned promise of immersive virtual reality experi-
ences. However, both require a seriously beefed-up PC—not a
Mac, either—along with a significant investment, with the Rift

priced at $600 and the Vive trumping it at $799.
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EXPERIENCE VR ON YOUR iPHONE

That’s premium VR, obviously.
What about the low end? Well,
assuming you have an iPhone 5 or
newer, you can try out mobile VR
using a simple viewer shell, and
Google’s Cardboard platform is the
easiest way in. Cardboard lets you
buy or even build a viewer made of
low-cost materials, and then slot your
phone in to use as the brains and the
screen. And then you’ll hold it up to
your face and stare into the future.
Or, at least, a pretty cool diversion.
Cardboard isn’t anywhere near as
immersive or impressive as the Rift or
Vive, or even Samsung’s Gear VR
headset (go.macworld.com/sam-
sunggearvr)—but at minimal cost, it’s
a neat way to check out virtual reality

\
®
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t

GET NEW APPS

using the device you already own.
Eager to try it out? Here’s what you
need to know.

Rather than use a dedicated screen
and processor, Cardboard relies on an
affordable shell with specialized lenses,
using your iPhone to do the heavy
lifting. Depending on your viewer of
choice, the iPhone will either slide or
strap in, and then once you fire up a
compatible app or game, the image will
be split into two halves on the screen.
Stare into the lenses and the two GOOGLE'S OWN
Cardboard app
includes fun demos,
and it can point you

toward other apps to
download too.

images are combined into one
immersive, 3D image, and most
Cardboard apps use your phone’s
gyroscope and accelerometer to let

GET NEW APPS
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you freely look around the virtual
world. Cardboard isn’t a hugely
interactive platform, so games are
pretty simplistic, but it's a great way
to view 360-degree videos and
photo spheres, along with other
visual experiences.

Cardboard first launched in 2014
exclusively for Android, and as user
and developer support grew, so too
did Google’s own focus on the
platform. In the summer of 2015, the
company released the enhanced 2.0
viewer blueprint and added iOS
support, launching the official
Cardboard app (go.macworld.com/
cardboardapp) and letting app
makers bring their VR experiences to

the App Store.

The core Cardboard app isn’t
required to use a Cardboard viewer—
any VR app designed for Cardboard
can launch and work independently
without Google’s main app installed.
However, it’s a nice introduction to
the world of mobile VR and has a
handful of neat VR diversions to
check out, such as a dazzling kalei-
doscope and some 360-degree tours
of various locales.

When Google first launched Card-
board, it had a very strong DIY ethos
around it—but then a whole commu-
nity of resellers quickly spawned

UNOFFICIAL CARDBOARD’S 2.0

Plus viewer adds little tabs for
adjusting the position of each lens,
but otherwise it’s similar to the
standard 2.0 cardboard viewer.
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EXPERIENCE VR ON YOUR iPHONE

THEVIEWMASTER VR is
sturdy and comfortable,
although the clamshell
latch doesn’t always
hold tight.

around the concept, each offering
their own commercial take on the
viewer. Google itself doesn’t make or
sell Cardboard viewers, but it has
given an official “Works with Google
Cardboard” stamp (go.macworld.
com/getcardboard) to many manufac-
turers that make viewers of all sorts.
The most common Cardboard
viewer is, quite literally, made primar-
ily from cardboard. Companies like
Unofficial Cardboard ($15, go.
macworld.com/cardboardwwgc), | Am
Cardboard ($20, go.macworld.com/
imcardboardv2), and Knoxlabs ($24,
knoxlabs.com/products/knox-v2) all

O RF..Oom

sell versions that are mostly similar
aside from small differences in build
and components. Each comes with
the lenses and a conductive touch
button, and they’re lightweight and
easily customizable. Unofficial
Cardboard also has a 2.0 Plus viewer
($20, go.macworld.com/ucardboard-
20plus) that tweaks the design with
adjustable lenses and an optional
headstrap.

We’re also seeing more plastic and
foam options, some bigger and
stronger than the cardboard viewers
and others smaller and more por-
table. Mattel's View-Master VR ($30,
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view-master.com) is a neat option:
When | wrote about it for our sister
site Greenbot (go.macworld.com/
viewmasterrev), | praised the sturdy
build and comfortable fit against your
face, although the latch was a little
finicky. Holding my heavier iPhone 6s
Plus, sadly, the latch is even more
prone to popping open. That’s
disappointing, but | still think it’s a
good overall option, and an improved
second-gen model is coming this
year.

Otherwise, there’s the Go4D
C1-Glass ($15, go.macworld.com/
go4dciglass), which snaps onto your
phone, or | Am Cardboard’s EVA

MERGE VR’S GOGGLES are
pricey, but they come
with big perks compared
to the cheaper options.

Coft CoXar.oom

Foam viewer ($25, go.macworld.com/
imcardboardeva), which is similar to
the cardboard viewers in design.
Merge VR’s Goggles ($99, mergevr.
com/vr-goggles) are a much sturdier
option with a head strap and an extra
input button for compatible apps,
meanwhile, and it’s hard to overlook
the novelty of the handmade Knox
Aluminum VR Viewer ($85, go.
macworld.com/knooxalum), which is
only recommended for the iPhone 6
and 6s.

Even with all of those options, you
can still make your own: Google
provides the plans and points you to
places that sell the components—and
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EXPERIENCE VR ON YOUR iPHONE

some sites sell all the non-cardboard
pieces in a bundle, like | Am Card-
board’s $10 parts bundle (go.mac-
world.com/imcardboardpartsonly).
Just note that it will take a fair
amount of precise cutting to get the
viewer into working shape. Still, it
could be a fun weekend project.
Lastly, if you don’t want to buy a
Cardboard viewer but also don’t want
to make one yourself, keep an eye
out for promotional giveaways—
they’re becoming more common. The
New York Times gave out more than
a million free viewers to subscribers
last fall (go.macworld.com/cardboard-

O RF..Oom

VIDEO

To view this video,
go to go.
macworld.com/
vriphone

nyt), but Verizon also gave away free
Star Wars—themed viewers (go.
macworld.com/cardboardverizon)
before The Force Awakens came
out, and other companies have done
similar mass handouts to promote
app and media releases.

Cardboard has been available for
iPhone for a much shorter span than
Android, so it’s not surprising that
there are fewer overall apps avail-
able. Still, many of the most interest-
ing options are available on the App
Store, and nearly everything is free.
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We profiled 11 apps worth a look
(See page 90), many of which are
focused on immersive news reports
and documentaries, as well as photo
spheres and other quick diversions.
Beyond those, you might also con-
sider Proton Pulse ($3, go.macworld.
com/cbprotonplus)—a delightful
arcade-style brick-breaking game
where you use your gaze to control
the paddle—as well as Vanguard V
(free, go.macworld.com/vanguardv), a
dazzling one-level space shooter
demo from the same developer.

The official Star Wars (free, star-
wars.com/games-apps/star-wars-app)
app also has some amusing shorts

THE STAR WARS APP
offers a series of
free “Jakku Spy”
360-degree videos
toenjoyinVR.

inspired by The Force Awakens, while
Sisters (free, go.macworld.com/
sistersvr) is an unsettling, albeit brief
horror experience. Besides all of
those, we recommend hitting the App
Store and downloading anything that
catches your eye: Again, most Card-
board apps are free and offer com-
pact experiences, so you might as
well sample the buffet of VR options.

More than five million Cardboard
viewers are out in the world now,
which means more and more people
are checking it out—and more and
more interesting apps and games will
come, too. Now you can jump in
yourself and give it a look.
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11 GREAT
VIRTUAL

REALITY APPS
THAT YOU
SHOULD
TRY OUT
RIGHT NOW

By Jackie Dove
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f a picture is worth
a thousand words,
then virtual reality
must be worth a
million. That’s because
unless you are present
on the spot, there’s no

\
%\

way a single photo or

video can convey the

desperate squalor of a refugee camp or the weightless sensation of
floating in space. As a passive observer, you merely witness; with
VR, you’re where the action is.

The key to VR’s power and growing popularity is presence—the
sense of being immersed in time and space regardless of actual
location—accomplished by an artful fusion of still images, video,
animation, and interactivity viewed through a head-mounted display.

While VR and gaming have always gone hand-in-hand—
relegating it to a niche audience—the genre is rapidly evolving to
include journalism, creative filmmaking, and mainstream storytelling.
VR is not just for recreation anymore.

And that’'s where Apple’s new interest (go.macworld.com/
appleintovr) in the tech comes into play, despite Tim Cook’s muted
praise during Apple’s most recent earnings call.

Whether you own a simple Cardboard (go.macworld.com/
getcardboard) viewer or one of the more expensive iPhone
compatible plastic or foam headsets, there’s plenty to see and do
with VR.

The past year has seen an explosion of VR content in every
category for both iOS and Android smartphones, and a huge
number of apps are available for free.

Here are some of our favorites.
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FEATURE

11 GREAT VIRTUAL REALITY APPS

Vrse

For non-gamers who see VR as an informational and news vehicle,
Vrse—a PBS, HBO, or Pixar kind of app—lets you tap into a spectrum
of cultural, topical, and political content. Vrse (vrse.com), which
partners with The New York Times, the UN, NBC, and other main-
stream news outlets, offers presentations shot in 360-degree video,
which you can watch either in a browser or on your phone or in VR
via a headset. “The Displaced,” for example, takes you inside various
refugee camps while “Walking New York” offers a unique overhead
perspective of an immigrant-based visual project. Vrse does not
offer a huge selection, but each piece, produced by its own Vrse
Works, has newsworthy or artistic value.
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Jaunt Player

Jaunt’s (jauntvr.com) specialty—the art of storytelling through
cinematic virtual reality—employs 360-degree stereoscopic 3D
imagery with directional audio, for superlative productions. For
starters, you can view news and cultural selections like Paul
McCartney’s “Live and Let Die” or “Zombie Purge,” but there’s
more: The company has invented its own proprietary VR camera
system called Neo (pictured here), which features custom optics

for 3D light-field capture, large format sensors, time lapse, high-

frame-rate capture, and tools for configuration, rendering, and
asset management. Working with creative brands, artists, and film-
makers, Jaunt also integrates with popular industry tools like Avid,
Premiere, Final Cut Pro X, After Effects, and more.
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13 VUV 11 GREAT VIRTUAL REALITY APPS

DNEWS

HEARING COLORS

Discovery VR

Discovery—the famous TV company (discoveryvr.com)—propels a
— 30-year-old historical enterprise into the future. With its storytelling
cred down to a science, the Discovery VR app lets you dive into
various locales in pieces from “Let’s Go Places,” “Puppy Bowl,”
“MythBusters,” “Racing Extinction,” “Gold Rush,” “Wildlife,” and other
programs. Discovery VR’s 360-degree videos can be viewed on
your desktop in most browsers. But for the immersive experience,
download the app for your iPhone or Android device to work with
your headset.
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VR One Cinema

Zeiss, famed manufacturer of professional camera lenses, is now
putting a new spin on movie night. With its branded VR One (zeiss
vrone.tumblr.com) headset and companion app (go.macworld.com/
zeissvroneapp), you can watch movies on the “big” VR screen in a
dark, immersive theater environment, complete with curtains,
seating, and other patrons. Zeiss does not distribute content, but
rather a more interactive way to watch videos you already have from
various sources. Dig into your iTunes or Camera Roll non-DRM MP4
movies or view downloaded 3D side-by-side (SBS) movies through
your Cardboard-compatible headset.

Select your video by turning your head to activate the menu. In
addition to providing a 3D movie theater, an intuitive interface lets
you play/pause or select among various videos.
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13TV 11 GREAT VIRTUAL REALITY APPS

NYT VR

Leave it to The New York Times to push its vast mainstream, non-
tech audience into VR via its branded app, NYT VR (go.macworld.
com/nytvr). If you notice some similarities between the content on
Vrse and NYT VR, that’s no accident because Vrse collaborated with
the newspaper on several of its headline VR projects, the most
famous of which, “Walking New York,” was featured on the cover of
the Sunday magazine. NYT VR video must first be downloaded to
watch in a viewer—the app does not stream content.

After viewing, tap Remove Video on the gallery or video detail
screen to move the file off your device. The 360-degree videos can
also be watched without a headset either on the phone or in the
browser. The New York Times produces additional VR-based news
and cultural programming and is updating its catalog each month.
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inVR

Some VR players are simply viewers that hook into third-party
content, but InVR (invr.co), a user-generated content platform, lets
you both create and view VR video from others on the network.
Made for the Google Cardboard app, InVR lets you use a host of 3D
packages (Maya, Max, Blender, or SketchUp) to create your own
original content, and export files to InVR’s cloud. The app builds your
creation for you, which you can later view and share with others.
Most of the public videos are animated works of art that you are free
to download and walk through. And there’s a command that lets you
create and share a GIF of anything you see.
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13 VUVl 11 GREAT VIRTUAL REALITY APPS

Vrideo

With Vrideo (vrideo.com), VR video content morphs into a YouTube-
style social networking and hosting platform. Not only does the app
let you stream content through a headset and tilt and pan your
phone to adjust your view of 360-degree video, a sophisticated
interface tells you which videos are trending, and lets you browse
categories like News & Politics, Travel & Events, Gaming, Vehicles,
and more.

You can create an account, subscribe to channels, like or dislike
videos, and build playlists. You can even play back videos without a
network connection.

Click + Drag

Want to use your
keyboard, gamepad,

or mobile device?

Have a headset
and want to watch

in virtual reality?
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Playback TYPE:

Mobile Station VR

If you're looking for both vast variety and granular control over
what you see and how you see it through your headset, look to the
Mobile Station VR (go.macworld.com/mobilestationvr) media player
for a ton of fascinating options. Its head-tracking technology let you
view photos, videos, and panos from different perspectives, which
are projected onto a floating screen. Various screen projections
include Curved, Full Dome, Plane, Cylinder, and Sphere Upload,
which you choose by moving or tilting your head.

You can also watch your own creations in MOV, M4V, and MP4
file formats. Numerous instructional videos posted on YouTube and
a 31-page user guide (go.macworld.com/mobilevrguide) alert you
that there are plenty of permutations and a learning curve to using
this app. But once you get the hang of the interface, there’s plenty
to enjoy.
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13 VUVl 11 GREAT VIRTUAL REALITY APPS

InMind VR

This arcade-style adventure game (inmind.nivalvr.com) concentrates
on getting inside the human brain to track down the neurons that
cause mental illness. Fast-paced with excellent graphics, the presen-
tation—which can be played via a VR headset or on your phone—
depicts a surgical prototype bathyscaphe scaled down to a fraction
of its original size, moving through the brain. Your job is to target and
neutralize those cells. A companion app, InCell (incell.nivalvr.com) is

also available via an in-app purchase.
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Seene

Seene (seene.co), a creation and viewing app for Cardboard-com-
patible smartphone viewers, lets you capture and share your own
photorealistic world by merging image, depth, and movement into a
scene, video, GIF, or JPEG. The app’s built-in utility facilitates cre-
ation of your own 3D scenes, complete with adjustable depth of field
and artistic filters. Seene technology incorporates 3D face capture
and scene construction, 2.5D scene reconstruction and computa-
tional photography, object tracking, and augmented reality. Social
network sharing lets you choose channels and create sets, like and
comment on scenes, view in VR, create a GIF animation or video,
and save it to your Camera Roll.
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13 NIV 11 GREAT VIRTUAL REALITY APPS

Ryot VR

11 Watch the evening news in VR with Ryot (ryot.org/virtualreality). This
production company sends reporters all over the planet, including
dangerous war zones, to produce stellar 360-degree and VR stories
on a daily basis. The production values are slick but the information-
gathering technique is solid and, as an added kick, it's designed to
inspire action on the part of the viewer. New selections each day
assure fresh content and each story has built-in contact and activist
references in the browser to help viewers be part of the solution

rather than merely passive observers of a problem.
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Do you have a favorite?

This is just a small sampling of the vast variety of VR apps being
released for this marketplace. Check out YouTube 360 (go.macworld.
com/360video) or the Google Cardboard apps (go.macworld.com/
apps4cardboard) site for more.

To browse the App Store sans iTunes, check out fnd (go.mac
world.com/fndiphonevr) for links to and descriptions of a large
selection of documentaries and games. B

You ™D - s
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wo R KI NG M ‘ Tips, Tricks, and Tools to Make You
and Your Mac More Productive

How to boost
your Wi-Fi
signal without
any tricks

The higher-frequency flavor of Wi-Fi
used by 802.11n and 802.11ac can have
higher power output and further range
by picking the right channel.

'BY GLENN FLEISHMAN
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frequent reader problem related to Wi-Fi—one | hear
all the time as a result of having written books about
Wi-Fi and Apple’s AirPort base stations for a
decade—is getting good coverage, even when a

network is seemingly well planned. But there’s one simple
change you can make that could have a surprisingly strong
effect. There’s a signal-strength property that’s not well known.

Modern Wi-Fi adapters and base
stations can use two frequency bands:
2.4GHz and 5GHz. The lower-fre-
quency 2.4GHz band suffers from a lot
of competing uses beyond Wi-Fi
(Bluetooth, baby monitors, industrial
sealers, microwaves, medical devices,
and a lot more), but it’s better at
penetrating walls, floors, and ceilings
than the higher-frequency 5GHz. The
802.11b, g, and n standards can work
over 2.4GHz.

The 5GHz band gets used by
802.11a, 802.11n, and the latest

Wireless Options

5GHz network name:

Country: United States

802.1ac—unlike the n flavor, the ac
type only works over 5GHz. The
2.4GHz channels overlap one
another, and in America, the best
ones to choose to avoid this overlap
are 1, 6, and 11. (You'll get advice
about using other channels, which is
usually bad advice because you wind
up getting interference from more
channels that way.)

In the 5GHz band, channels don’t
overlap, and there are a bunch of
them available—eight using Apple’s
current base station generation and

<>

Create hidden network

2.4GHz Channel: 9

5GHz Channel: 149

<>

<>

Cancel
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for the two frequency
bands used by Wi-Fi,
but also set a distinct
5 GHz network name
to separate out
usage.
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BOOST YOUR WI-FI SIGNAL

e e
Netwark Name
Total 10 Centurylink1484
2.4 GHz Count 5  Not5GHzApplicable
5 GHz Count 5  pebblebeach
Current Channel Count pebblebeach
Best 2.4 GHz g1 Portage Airbasestation
Best § GHz 4p, Portage Airbasestation

Portage Airbasestation

Portage Airbasestation

more using equipment from some
other makers. That makes interfer-
ence less likely. Both 802.11n and
802.1ac can bond together multiple
5GHz channels, which is how they
push through hundreds of Mbps to
nearly 1Gbps depending on the
circumstances.

But here’s the thing you probably
didn’t know. The 5GHz band has
different power restrictions based on
which channel is used. The lower-
numbered channels on Apple
hardware (36, 40, 44, and 48) can
use just five percent of the power of
the higher-numbered channels (149,
153, 157, and 161). That twenty-fold
difference is huge. (These channels
are available in the U.S,; not all 5GHz
channels are available in every
country, as regulations vary.)

Apple’s base stations and those of
most manufacturers are set by
default to choose Wi-Fi channels
automatically. Some base stations
prefer the higher-numbered, higher-
powered channels, but others pick

[ T r————

Scan

Protocol

BO2.11bjgin 69

WPA/WPA2 Perscnal

cé:ea:1d:B6:chad  WPA/WPAZ Personal 802.1ac 46
90:72:40:18:03:fe  WPAZ Personal 802.11bjgin 72
90:72:40:18:63:6f  WPA2 Personal 802.11ac -78
28:che®Bl:5a:8a WPAZ Persona 80211bjgin -T2
28:cf:e8:81:50:6b WPAZ Personal 802.11a/n -81
60:e3:27:ad:dc:.. WPA/WPAZ Personal  802.11ac -a0

60:e3:27:ad:de:f7  WPA/WPA2 Personal 802.11bfgin -43

the least-congested channel.
Because channels 149 and up can
push out more power, they can also
be “heard” from farther away, and
are thus likely to seem like interfer-
ence to a router trying to find an
uncongested channel.

You can see what channel a base
station has been assigned to using
OS X by holding down the Option
key and selecting the Wi-Fi menu,
then selecting Open Wireless
Diagnostics. In that hidden app,
choose Windows » Scan, and you
can see all base stations within range
with a variety of details, including
their channels.

If you’re having poor coverage
with your existing 802.11n or 802.11ac
base station and you see it's
assigned to channel 36 to 48, launch
AirPort Utility:

Select your base station and
click Edit.

Enter the password if prompted.

Click the Wireless tab, and click
Wireless Options.
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Scan Now

THE WIRELESS
DIAGNOSTICS program
has a scanner that
shows you all the
base stations around
your Mac.
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From the 5GHz Channel menu,
select 149 or higher.
Click Save and then click

Update. Your base station will restart.

If you want to be sure to lock
devices to the higher 5GHz band,
there’s no setting in iOS nor in OS X,
but you can use that same Wireless
Options dialog to check 5GHz
Network Name and name that base
station (or each base station you

have) to a distinct name from the
2.4GHz network.

Then, on every device you want to
lock to 5GHz, use Settings » Wi-Fi in
iOS or the Network preference
pane’s Wi-Fi adapter’s Advanced
dialog to forget the 2.4GHz network
name. Connect to the newly named
5GHz network, and all your devices
that support 5GHz (all modern
hardware) will only use that band. m
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Send Message
Share Contact

Add to Favorites

How to back up your contacts
on your iPhone and Mac

When it comes to backing up your address book data, you have a few options.

BY NICK MEDIATI
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t goes without saying, but digital address books are great.

You have instant access to all of your contacts, and your

brother’s phone number is just a few keystrokes away. But

just as you can misplace your real-world address book, you
can just as easily lose your digital one if you aren’t careful. Read
on, and we’'ll show you a few ways to safeguard your precious
contacts list.

CLOUD SYNCING SERVICES: have to hop from service to service

A PRIMER to find the person you’re looking for.

The easiest, most pain-free way to For all these services, you can

store your contacts is to use a view and edit your contacts’ info

cloud-based contacts management through a website that you can

service. Most of the big-name email access on just about any computer,

services—Google’s Gmail, Microsoft tablet, or smartphone. Many of these iCLOUD OFFERS THE
Outlook, Apple iCloud, and Yahoo third-party (non-Apple) services also requisite email,
Mail—offer some sort of contact offer their own iOS apps, but these contact management,
manager. And since they’re fully apps often lack full-fledged contact zgfvicise’n;irsa ot
integrated with your email, you don’t management capabilities. more.

=NB008S

Mail Cantacts Calendar Phataos iCloud Drive Notes Reminders

Numbers Keynote Find Friends Find iPhone Settings
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BACK UP YOUR CONTACTS

You can usually access
contact information
stored via services like

iCloud

" iCloud Drive Options
Gmail or Yahoo Mail
. ) 1 Ph tions
through i0S’s bundled @) Phows o
apps, but caveats A e
abound, as we’ll see in a
‘ Contacts
moment.
Account Details =
Finally, there’s an : (i Calendars
Set Up Family
inherent risk to storing ) Reminders
your contacts’ informa-
. . o Safari
tion in the cloud—
namely, someone with Notes
nefarious intents to Sign Out ntall 4.08 GB Available Manage.
break into your account
or breach a provider’s
servers—but for most people, the If you don’t have iCloud Contacts MAKE SURE THE

benefits of these services outweigh
the risks. Strong passwords (go.
macworld.com/strongpw) combined
with other good security habits—like
using two-factor authentication (go.
macworld.com/2factorauth)—can miti-
gate these security risks to a degree.

Without further ado, let’s look at
some of your options.

SYNCING CONTACTS WITH
iCLOUD

If you're fully entrenched in the Apple
universe, using iCloud to manage
your contacts might be the easiest,
most straightforward way to go.
iCloud will keep all your contacts in
sync across your Apple devices, so
it's pretty pain-free. Plus, you likely
already have it turned on.

Coft oXar.oom

Contacts option is
enabled in order to
sync your address
book on your Mac.

turned on, you can easily change
that: On your Mac, open System
Preferences, then click iCloud. Sign
in to your iCloud account using your
Apple ID if you have one—if you
don’t, head to iCloud (iCloud.com) to
get started—and once signed in,
check the box for Contacts.

On iOS, go to Settings = iCloud,
then switch the Contacts toggle to
the On position (it'll turn green).

USING SERVICES LIKE GMAIL,
YAHOO MAIL, AND OUTLOOK
Apple has a clear self-interest in
steering you toward using iCloud, but
Apple’s service isn’t the only option
you have for storing, managing, and
syncing your contacts across
devices: Google, Microsoft, and
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others offer tools that let you manage
and store your address book. Sadly,
none of these services work quite as
seamlessly on iOS as iCloud does.

While all three companies offer
iOS apps for their respective email
services, not one provides a full-
fledged contact-management tool for
iOS: You either have to use your
email provider’s website or use
Apple’s built-in Contacts and Phone
apps to manage your data.

To set up your iPhone’s Contacts
and Phone apps to work with any of
these services, go to the Settings
app, then tap Mail, Contacts, Calen-
dars. Tap Add Account located under
the Accounts subheading, then tap
the appropriate service (Google,
Outlook, Yahoo, and so on). Next,
follow the onscreen prompts to log in
to your account—the process varies
slightly depending on the service, but
it's pretty straightforward regardless.

Setting up the Contacts app to
work with your contacts service is
similarly straightforward: Open
System Preferences, then select
Internet Accounts. Pick the service
you want to use, then follow the
onscreen instructions to set it up.

In terms of third-party apps, the
Mac offers a little more flexibility, so
you aren’t stuck with Web interfaces
or OS X’s bundled apps. Microsoft
Outlook for OS X lets you manage
your contacts in addition to calendars

Coft oXar.oom

and email, and like Outlook for iOS, it
works with a wide variety of services.
It also isn’t the only third-party option
available for OS X.

If you'd like to try something new,
BusyContacts (go.macworld.com/
busybontacts) ($50) (go.macworld.
com/busycontactsapp) is one option
worth looking into. It is a $50 applica-
tion, however, so it may be a little
steep for some users, but it might be
worth a look if you need something
more powerful.

MANAGING MULTIPLE
ACCOUNTS ON I0S

Using multiple services to manage
contacts on iOS is a bit cumbersome,

seeee ATET 4G 12:256 AM ¥ 52% M}

£ Mail... Add Account

%iCloud
@B Exchange
Google
YAHOO!
Aol.

8% Outlook.com

m

i0S SUPPORTS A
number of popular
email and contact-
management
services.
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BACK UP YOUR CONTACTS

so for the sake of
simplicity, you'll
probably want to pick
one service and run
with it.

If you already have
multiple contact-sync
services set up on
your Mac or iOS
devices—say, you
use Gmail and
iCloud—you can turn
off the contacts
feature on your
devices. By doing so,
however, you may
have to delete some
contact information
from your device, so
it's probably best to leave everything
turned on.

In such a case, your best option is
to set a different default account for
contacts storage—useful if you want
to use iCloud for things like Photos
and Notes but want to switch to
Gmail for email, contacts, and calen-
dars. To make the change, go to
Settings = Mail, Contacts, Calendar.
Scroll down to the Contacts section,
then tap Default Account. From there,
pick the account you want to save
new contacts to.

This isn’t an ideal setup—in a
perfect world, you would be able to
easily specify where to save a
contact card as you create or edit

[ T r————

eseeee ATRT 4G

< Mail...

iCloud

12:27 AM

Default Account

1 s dek@gmail.com

it—but you can change your default
contacts account at any time.

GETTING THE JOB DONE
WITH EVERNOTE
Evernote is a useful tool for note-taking,
and like the services mentioned above,
it lets you access your data from all
your devices, either via dedicated apps
or the Evernote website. It wasn't really
designed as a contacts manager, but
it's powerful enough that you can use it
to store your contacts if you really want.
Open your Evernote app (or head
on over to Evernote’s website) and
create a notebook to store your
contacts. Next, create a new note for
each contact: You'll have to format

12
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New contacts created outside of a specific
account will be added to this account.
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DIFFERENT service to
store your contacts?
You can do that with a
few taps.
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each one manually, but notes are
fully searchable so you can easily
find the info you’re looking for.

THE IMPROV WAY
If you use a cloud storage service
like Dropbox or OneDrive, you can
manually back up your contacts, but
it requires a little improvisation.
Making a list:
Manually cobbling
together a list of
contacts isn’t exactly an
ideal solution, but it can
work in a pinch. If you
use a cloud storage
service, you can toss
your contacts into a
text document that you

COBBLING TOGETHER A contacts

select everyone in your contacts list
by going to Edit = Select All. Go to
File » Export as PDF, and then give
your file a name and choose where
you want to keep it, then press
Save. You'll get a full readout of your
contacts that you can take with you
or print out.

Exporting an archive on your
Mac: Another option is
to export your address
book from your Mac’s
Contacts app and save
it to your cloud storage
service of choice.

Open the Contacts
app on your Mac: Go to
the File menu, mouse
over Export, then select

list and uploading it to Dropbox

can update as needed.
Updating can be
tedious, however, so
this isn’t something you’ll want to do
unless you have to.

Alternatively, if you use OS X’s
Contacts app, you can create a PDF
list of your contacts: Open the
Contacts app on your Mac, then

is one quick-and-dirty way to
back up your contacts.

Contacts Archive from
the submenu that
appears. Give it a name
and choose where you want to save
your archive, then click Save. If you
ever need to recover your contacts,
open the Contacts app, select File »
Import, choose your contacts archive,
and you’ll be back in business. B

13
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Reasons to love TextEdit, a secret
powerhouse of rich text

A utility that dates back before OS X to Next’s operating system still delivers
a punch for handling text formats and converting one to another.

BY GLENN FLEISHMAN

14
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oor little TextEdit! Despite having a rich history—start-
ing life as Edit (go.macworld.com/nextedit) in the
Next's NextStep operating system before becoming a
feature in Mac OS X—the app gets little regard. But it
deserves our attention. It’s the best and simplest place to go in
OS X for converting among text formats and has features that
are still missing in Pages 5 after they disappeared in the bump
up from Pages 4 (09).

TextEdit seems like a homely little new one. Click Create Document,

app. When launched, it doesn’t and you’re presented with a

present a list of templates and stripped-down screen. It looks true
folderol. Rather, its dialog box lets to its origins, like something from
you open a document or create a the 1990s.

[ UNTITLED.Af — ~ = TEXTEDIT EVOLVED
infa i S sy Y FROM the original
File = I R ) "l O ™R SR LA W il G R NextStep Edit
Edit r program.

Format I

Windows

Print..  p

Services I

Hide h

Quit q

Find B3
Find:|]
Replace wllh:[
Replace All Scope Find Options
(" Entire File “llgnore Case
(" Selection __|Reqgular Expression
Replace All I Replace | Replace & Find | Previous I Next (""I
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REASONS TO LOVE TEXTEDIT

I've turned to TextEdit dozens of
times recently, and I've referred
readers, friends, and family to it when
Pages 5 doesn’t cut it for their needs.
Here are a few key examples of
where TextEdit helps.

FORMATTED TEXT IS ITS
NATIVE LANGUAGE

At its heart, TextEdit is a rich-text
engine and that’s because its native
encoding is Rich Text Format (RTF).
RTF is widely supported and decades
old, developed originally by Micro-
soft. It's an interchange format that
can preserve formatting, like a bold
text style and type size, while also
incorporating images, font refer-
ences, and comments.

While Microsoft’s word-processing
formats, .doc (pre-2007) and .docx
(Word 2007 and later), are somewhat
universal at this point, there’s often a
mismatch between formats with
which you’re presented to open or
save as and those you need, espe-
cially if you’re using Pages, Open-
Office, or Word as the hub through
which data passes.

TextEdit can open Word files (the
older .doc and newer-but-now-quite-
old .docx formats), Open Document
.odt files (from OpenOffice and other
programs), RTF, and plain text files. It
also handles HTML, which can be
displayed either as rich text with
embedded formatting and links or, by

[ T r————

changing an item in TextEdit prefer-
ences, as raw HTML. (RTF files can
also be edited in their raw format, but
this is much less typical and useful
that you’ll need access to their
underlying code.)

It supports Safari’'s Web Archive
format (File » Save As and select
Web Archive from the Format menu),
which preserves
all the content on

a webpage, | FREQUENTLY USE
though when TEXTEDIT AS A
TextEdit opens it, CONVERTER, TOO,

it's not necessar-
ily perfect at
rendering the
page as it
appears in the
original. However,
by including
formatted and
linked text along
with images, the format makes it
possible to take a page in a browser
and in TextEdit extract its text or turn
it into a word-processing file.

| frequently use TextEdit as a
converter, too, because not only can
it open all of those formats, it can
save files out in a wide variety of
formats. (To see the options, hold
down the Option key while selecting
the File menu and select Save As,
which replaces the default Duplicate
menu item. The formats are listed
under the File Format drop-down.)
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File Format| ¥ Rich Text Document ,
Rich Text Document with Attachments

Hide extension New Folder

Web Page (.html)
Web Archive Document

OpenDocument Text (.odt) Document
Word 2007 (.docx) Document
Word 2003 (.xml) Document

member these tags next time

Rich Text Document (RTF, saved
as .rtf)

Rich Text Document with Attach-
ments (.rtfd) creates a bundle with an
RTF file and all the referenced images.
This is often a great way to take a
document with embedded images
and, instead of copying and pasting
each image separately, creating
essentially an exported directory with
every image contained. (To see the
images, you right-click the .rtfd file,
and select Show Package Contents.)

Web page (.html)

Web Archive Document (webar-
chive), discussed above

And a range of word-processing
formats: OpenDocument Text (.odt) and
three Word formats: .doc, .xml, and
.docx. TextEdit identifies these as Word
97, Word 2003, and Word 2007,
respectively. The .doc format remains
the baseline for a lot of older software.

SEARCH AND YOU SHALL
RE-FIND

Many choices Apple made in creat-
ing Pages 5 have left users and this

Coft oXar.oom

Word 97 (.doc) Document

writer baffled, but none more so than
the removal of advanced search-and-
replace options. Search-and-replace
is one of the best parts of word
processing after actual typing and
spellchecking, as it allows you to find
problems or matches throughout and
optionally fix them. If you misspelled
a word consistently (or even inconsis-
tently), you can find all its iterations
and replace them with the right
version. Or you can check if you've
overused a term.

The Pages 5 find features have
little sophistication, but you can turn
to TextEdit when you need more
advanced options. Save your Pages
5 file as a .docx file (File » Export As
= Word with default settings) to best
preserve all its formatting, then open
it in TextEdit. (Yes, it's more than a
little peculiar that Apple’s text utility
can handle Microsoft and Open
Document formats, but not its own
Pages’ files, whether Pages '09/
version 4 or Pages 5.)

In TextEdit, press Command-F (Edit
= Find » Find), and a search field

17
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TEXTEDITHAS A huge
array of file export
options.
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REASONS TO LOVE TEXTEDIT

opens at the top of the window for
quick searches. As you type, a count
appears at the right of the field for
the number of matches. Check the
Replace box and now you can swap
in results, too (or select Edit » Find »
Find and Replace, or press Com-
mand-Option-F). An oddly divided
Replace and All conjoined button
corresponds to “replace just the next
match” and “replace all matches in
the file”

Click the magnifying glass icon,
and a drop-down menu offers basic
options (like ignore case and full
word) found in Pages, but also lets
you select whether a pattern is at the
start of a word—like “key” finding
both “keystroke” and “keyboard”.

Click Insert Pattern, and you get to
the good stuff, where you can find
invisible characters like tabs, para-
graph breaks (returns), line breaks
(Shift-return), and page breaks, as well
as wildcards. TextEdit can also parse
and recognize email addresses, URLs,
and phone numbers.

The nifty part that’s hidden at first
is that you can also use patterns in
the Replace field, although ones
defined in the Insert Patterns pop-up.
So let’s say you want to find all email
addresses in a document that are
followed by a comma and a space,
then replace them with the address
followed by a paragraph return.

In the Find field, select the
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pop-up, select Insert Pattern, and
choose Email Address, and then type
a comma and then a space.

With the cursor in the Replace
field, click the pop-up icon and
select Insert Pattern, and you’ll see
only options relevant to replace,
which will include Email Address
because it’s used in the Find field.
Select that, then repeat to insert
Paragraph Break.

When you click All, all matches are
replaced in the document, preserving
the email address in each case. This
is a limited form of pattern-matching
replacement, something found in
more advanced and varied versions
in Word, BBEdit, and OpenOffice.
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powerful searches in
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CONVERTING FROM
MARKDOWN'’S HTML OUTPUT
INTO AN EDITABLE WORD-
PROCESSING FILE
| often write in Markdown (go.
macworld.com/markdowntext), an
explicit text-formatting language that
combines human readability with
parsing (in content-management
systems, blogs, native software, and
elsewhere) to let you tag lightly and
then run through a parser that spits
out nicely made HTML. However, the
path from Markdown to rich text or
.doc while retaining text formatting,
incorporating images, and keeping
hyperlinks active is often rocky.

TextEdit eased that path for me,
and you’ve got two ways to make
use of it.

| could open a Markdown-exported
HTML page from within a browser
window with images and all and
paste it into Pages 4, which appropri-
ately accepts rich-text pasting
between apps, then export that
document to RTF (holding down
Option, select File » Save As). (Pages
5 doesn’t offer RTF export.) That RTF
file can be opened in TextEdit and
exported as a Word .doc or .docx.

You can also work from the HTML

end, if you're not trying to incorpo-
rate images, and load an HTML file in
TextEdit, which renders it into rich

text while

preserving [

formatting and WE CAN ONLY HOPE
links. It doesn’t THAT PAGES 5.7 OR,
open refer- COULD WE EVEN
enced files. DREAM, PAGES 6

This can then
be exported as
.doc or .docx,
which can be
opened in
Pages 4 or 5. I..
In either case,
you wind up with an editable word-
processing document with everything
or nearly everything intact.

PAGES 5 FINAL FORM

While TextEdit is a stop gap for a lot of
routine purposes, Pages continues to
evolve. Apple stuffed more than one
would expect in minor releases in
Pages 5.5 and 5.6, see our review of
5.6 (go.macworld.com/Pages56),
restoring long-lost functionality. We
can only hope that Pages 5.7 or, could
we even dream, Pages 6 would bring
the power of TextEdit back into
Apple’s flagship word processor. B

119


http://www.softgozar.com

iCloud Photo Library requires
copying images to the Photos
for OS X app

Photos lets you reference images and duplicate them in its library, but
it won't upload them to iCloud.

BY GLENN FLEISHMAN
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s it possible to use iCloud Photo Library without actually
copying all the photos into the Photos app (the way iTunes
lets you use it as an indexer without storing the files in its own

central location)?

Unfortunately, no! Photos for OS X
does let you reference files without
making a duplicate copy in the
currently selected Photos library.

1. Select Photos =+ Preferences.

2. Uncheck the Copy Items To The
Photos Library option.

Any images or video you “import”
now create a thumbnail and a link in
Photos. If you want to see which
media is referenced, select View »

Metadata » Referenced File, and a
tiny icon appears in the lower left
corner of any such image.

However, if you have iCloud Photo
Library enabled, when you perform
step 2 above, you're warned by
Photos that referenced images won't
be synced. Foiled! This makes sense,
because Photos can “optimize”
images stored locally if you choose
that setting—keep a lower-resolution
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iCLOUD PHOTO LIBRARY

Smart Album Name:  Untitled Smart Album
Match the following condition:

Photo is referenced -+
28 items matched Cancel “

version for previewing—and it would SMART ALBUMS CAN find all referenced images in the library.
be strange to modify a file refer-
enced outside its library in such a . Consolidate Original Files into the Photos
fashion, or delete it. “ Hbrsoy

You can find all referenced images L T NN e e P
in a library by creating a new Smart

Album (File » New Smart Album) and Cancel
setting the criteria Photo, Is, Refer-
enced.

YOU CAN COPY referenced images into your Photos library.
Our colleague Jason Snell recently g y y

documented an interesting parallel

operation at his site, Six Colors, for that after selecting referenced
Ted Landau, a veteran Mac writer images (as with the smart album
and troubleshooter. Ted wanted to approach above), selecting File »
consolidate images he’d imported by  Consolidate will perform that
reference accidentally. Jason notes operation. |
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Using the Web for Video, Graphics, Publishing,
Photography, and Other Creative Pursuits

Macphun Creative Kit 2016:
Critical photo editing functions
delivered in one diverse app

With Creative Kit, Macphun wants to pick up where Apple’s now-defunct
Aperture left off.

BY JACKIE DOVE
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Creative Kit does not seek to replace
Photos’ organizational utility, though
Macphun (macphun.com) does
market a separate app called Snapse-
lect for organizing and choosing the
best photos from a batch and trash-
ing duplicates.

The Mac-only Creative Kit is a
six-app bundle that functions both as

Liquify...

a
Artistic

Blur

Blur Gallery
Brush Strokes
Distort

Noise

Pixelate
Render
Sharpen
Sketch
Stylize
Texture

Video
Other

Alien Skin

Digital Film Tools
Macphun Creative Kit
Macphun Software

Mister Retro
Nik Collection
Painter

Adaptive Wide Angle...
Camera Raw Filter...
Lens Correction...

Vanishing Point...

Browse Filters Online...

s a plug-in to Photos (go.macworld.com/photosforosx),
Macphun’s apps significantly augment the Apple
app’s bare-bones editing tools. Despite their power,
Creative Kit apps require a minimal learning curve.

a standalone app and a plug-in to
Adobe Photoshop, Lightroom (go.
macworld.com/lightrcc), and Elements
(go.macworld.com/elementsi4).
Available via a single installer for
one discounted price, Creative Kit
lets you access some of Macphun’s
most popular image enhancement
packages: Noiseless, Focus, Intensify,

File Edit Image Layer Type Select JEIC8 3D View Window Help

- lﬁ-
Filter Gallery...

Convert for Smart Filters

Y Y Y YV Y YYYTYVYIYYYY

Focus CK...
FX Photo Studio CK...

vy rhldv vy

Tonality CK...

125

YOU CAN ACCESS
Macphun’s Creativity
Kit directly from within
Adobe Photoshop,
Lightroom, or
Elements.
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Extensions Q

Use Apple and third-party extensions to customize your Mac.

| . .
M AT e ——— Select extensions for editing photos:
rActLons D Intensify CK
Finder h Tonality CK
Dropbaox, Core Sync

#¢ Fx Photo Studio CK

Photos e
Intensify CK, Tonality CK, and 3 mor... 9 Snapheal CK
Share Menu

Mail, AirDrop, Notes, and 3 more.

# Noiseless CK
& Affinity Develop

& Affinity Haze Removal
& Affinity Liquify

& Affinity Miniature

Tonality, Snapheal, and FX Photo
Studio. Each is also available as a
standalone app (though in your
Applications folder, they are separate
apps appended with a CK) and
variously support features like batch
processing and multiple file formats
including JPEG, PNG, 8- and 16-bit
TIFFs, PSD, and various flavors of
RAW.

Creative Kit component apps are
not new—just the all-in-one package:
Each app has been previously
released, and is still available sepa-
rately. But there are tremendous
financial and functional advantages
in purchasing the kit though even in

Coft oXar.oom

this update you can only work on
one photo per app at a time.

COMPONENTS

Intensify (go.macworld.com/intensify)
takes shots that looked a lot better
through the lens than they do on
your screen and lets you achieve
results that better resemble your
original vision—and in most cases
improves on it.

Focus, which includes a facial
recognition feature, spotlights
specific parts of your image after the
fact, letting you emulate intriguing
lens blur, tilt-shift, vignette and
motion blur styles. Tonality, a sophis-
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YOU CAN OPEN
Creative Kit apps as
extensions in Apple
Photos. Focus is not
an extension yet, but
it will be soon.
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ticated black and white editor, adds
old-fashioned drama and monochro-
matic special effects to portraits,
landscapes, and action shots.
Snapheal removes unwanted
objects, people, and flaws from your
photos while Noiseless (go.macworld.
com/noiseless) removes ugly pixel
artifacts from poorly lit shots.

INTERFACE
Choosing the plug-in gives you the
same interface as launching the app

.
@ Tonality &=

independently: It opens in its own
window and will either save in its
native format or export to a universal
format like JPEG or TIFF.

If you save in Macphun’s native
formats hoping that other CK apps
will read or open them, you'll be
disappointed. Focus, for example, will
not automatically open an image
saved in Noiseless MPN format.

Note that to use the apps as
Photos extensions, you have to
launch them independently once. TONALITY CK INTERFACE

+PRESETS + Dosste
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.
+ Intensify

Focus, the only app that does not
show up in Extensions, will be
updated soon, Macphun said, though
you can still use it in standalone
mode.

And, while the suite’s File » Open
In command is the easiest way to
bounce a photo among the different
apps without having to save, close,
and relaunch them, you will have to
save and relaunch if you are using
Creative Kit as an Apple Photos
extension.

App interfaces are similar but not
identical. The original standalone and
plug-in apps were created at differ-
ent times and with different functions,
so expect controls to be located in
various places.

The best part about Creative Kit is
that there’s no need for a manual.

Coft oXar.oom
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Just fire up each app and poke
around. There are an abundance of
presets to get you started, and quite
often the presets are all you need.
The Macphun website also features
video tutorials and guides that demo
the programs’ major functions.

For the most part, the app gives
impressive results without your
having to do much more than click
and keep your eyes open.

That’s not to say there aren’t
plenty of tweaking opportunities that
will put you in an alternative time
zone—you can literally experiment
for hours on a single shot. That’s
because each app has an abundance
of manual settings that work along-
side the presets.

If a portrait or landscape needs a
little more than a single preset
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offers—or the preset is the right idea,
but just too little or much—adjustable
sliders and manual controls are there
for fine-tuning. Most of the apps also
have a layers function that lets you
stack edits on top of each other and
switch them on and off.

There are also several ways to
view real-time edits: a side-by-side
view, a slider view, a compare button,
and a complete restore for starting
over again.

App performance, on the whole, is
swift on my 2013 MacBook Air. Preset
changes appeared instantaneously, for
the most part. However, if you use the

0
« |ntensify &=

b Boew P &

grabber hand to change the position of
an image on screen, the app will often
take a few seconds to rescan the
entire image in order to register the
details, which can get tedious.

INTENSIFY CK
Photoshop has a variety of sharpen
tools (including my favorite, Smart
Sharpen), but Intensify CK has so
much more for achieving precise
control over contrast, structure,
detail, and sharpening across differ-
ent tonal ranges—in one click—that
there’s no comparison.

Seven categories of presets—

ADJUSTABLE ROUND
BRUSHES let you paint
edits on to different
areas of your image.
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= Intensify =& = %

Architecture, Black & White, Creative,
Detail Enhancement, Landscape, and
Soft—which also feature up to 14
specific presets each, give you a
head-spinning array of sharpening
options.

Slider adjustments and layered
effects help you avoid that pixelated
over-sharpened look while at the
same time focusing your concentra-
tion on specific areas of the image
with layers and masks.

Intensify CK’s adjustment panel
offers eight categories with an
assortment of slider-based fine-
tuning tools.

Don’t rely on the names of the

Coft oXar.oom

(o0 1{F.y]-8 MACPHUN CREATIVE KIT 2016 REVIEW

adjustments, as it’s difficult to deter-
mine their exact effect. Just click
through all of them—previews are
very quick—to determine how to
proceed.

You don’t have to stick to the
presets that come with the program;
you can create your own. Save

Favorites and Custom presets right in

the interface for easy reach. The

app’s layers feature lets you combine

and brush in presets. Switch layers

on and off to see the effects in action.

The adjustable brush works well,
but it would also be nice to have
different brush shapes in addition to
round.
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INTENSIFY MASKING
TOOLS AND LAYERS let
you paint in effects
to specific parts of
your image to avoid
oversharpening.
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SNAPHEAL CK

If you’re familiar with Adobe Photo-
shop’s content aware fill feature, then
you get the point of Snapheal. Its
proprietary algorithm helps you
remove offensive or extraneous
objects or people from your photos
and analyze the surrounding context
to “fill in” what is “behind” the
removed item.

Snapheal’s three tabs—Erase,
Retouch, and Adjust—provided all of
the controls | needed to improve the
photo below. Editing tools such as
crop and straighten and adjustments
for contrast and clarity delivered a
fine rendering of my vision of what
the scene would look like.

..l

THIS SHOT—TAKEN AROUND midnight—has deep shadows, including the one in the middle of me taking the photo. Not pretty. | used

The app comes with three erase
modes, so if you don’t get the result
you like the first time, you can try
different ones. The Global mode
looks at the overall image while the
Local mode uses nearby pixels to
calculate a background fill. The
Clone tool helps to remove leftover
artifacts from the frame for a pristine
composition.

FX PHOTO STUDIO

Special effects are not mandatory for

photo editing, and many photogra-

phers eschew them altogether.
Taking an image into FX Photo

Studio special effects app can give

your run-of-the-mill picture much-

Snapheal to erase my own shadow from the shot while retaining all the natural shadows.
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needed drama—Instagram gone wild.
There’s nothing remotely complex
about the app: It provides 20 catego-
ries of effects from Art to Color
Lenses to Groovy Lo-Fi to Symmetry
to Vintage.

Just choose a category from the
pop-up menu or set it to all effects
and roll the dice (there’s a dice
icon) to see what you come up with.
The app’s controls include Effects,
Crop, and Adjust with familiar
controls.

But you don’t have to stop there: A
large selection of frames round out
the special effects.

TONALITY CK

Ansel Adams (go.macworld.com/
anseladams) is arguably the most
famous landscape photographer that
ever lived because of his haunting
black and white images of the
American West. Anyone who ever

Coft oXar.oom
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loaded a camera with Kodak’s Tri-X
or Panatomic-X film probably envi-
sioned emulating perhaps a small
sliver of what Adams was able to
capture. Macphun’s Tonality CK can
help recreate that drama for your
landscapes and portraits.

Tonality’s features plunge deeply
into monochromatic subtleties. Like
the other CK apps, Tonality lets you
begin with some 150 presets, some
actually created by photographers:
Basic, Architecture, Portrait, Dra-
matic, Outdoor, Street, Vintage, Film
Emulation, Toning, and HDR.

And as with the other CK apps,
these presets may be all you need,
though the layer-based interface
offers additional options.

For deeper control, a variety of tools
such as color filters, split toning, clarity
and structure, grain and multiple layers,
and authentic film emulation help you
fine-tune your vision.
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NOISELESS CK

The very definition of photography is
light, and with low light comes color
or luminance (light) noise—artifacts
that make even the best composition
unbearable to look at.

Noiseless, with ten adjustable
presets, helps you salvage noisy
shots and remove ugly colored
speckles from your smartphone or
DSLR photos without sacrificing
sharpness or clarity.

There are many utilities on the
market that do a similar job, including
Photoshop’s own controls. But |
found that Noiseless worked very

&) Focus

well, often with a single click.

The app’s controls are designed to
retain edge details, giving your
image a crisp but natural look.

FOCUS CK
Focus helps spotlight specific parts of
your image after the fact, letting you
create the popular bokeh effect, for
example, with a sharp foreground and
a blurred background in addition to
selective focus and vignette effects.
A face detection feature helps put
portraits into focus, too. Add motion
blur and tilt shift for a dynamic sense
of action.
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Don’t rely on the named presets:
Adjustable aperture settings for
Portrait, Nature, Architecture, Macro
photo, and Tilt-Shift let you enhance
portraits, street photos, and land-
scapes. Try each on your image to
determine which one is right, or use
selective masking to precisely
control blur and focus for photo
areas of your choice.

If you just want to highlight a
specific part of the image, use the
app’s masking function. The paint-
brush can mask the parts you want to
focus on and then choose the effect,
which shows up only for the chosen
part of the image.

BOTTOM LINE

Macphun’s Creative Kit is a super-
impressive entry into the bundled
photo editing app arena, rivaling
packages like On1 Photo 10 (go.

(o4;{7:YJ 58 MACPHUN CREATIVE KIT 2016 REVIEW

macworld.com/on1photo10), the
Google Nik Collection (google.com/
nikcollection), and Topaz Labs’
(topazlabs.com) vast collection. Its
flexibility, ample supply of presets,
and excellent performance help a
wide range of photographers—span-
ning amateur to pro—get quick
results.

Why purchase a suite? Because
chances are that over time, you’ll
need all of the included utilities, and
the deep discount available for the
package makes it a good investment
for use as either standalone apps or
plug-ins.

Creative Kit is an exceptional
bargain at $130 for the complete
package, as opposed to paying
prices ranging from $30 to $60 for
individual app components. A pro kit,
which includes a training package, is
available for $155. Tryouts are free. m
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g YOU ARE
YOUR MOST
POWERFUL
ADVOCATE.

MORE THAN EVER,
COLORECTAL CANCER
IS A PERSONAL MATTER.

Today, colorectal cancer (CRC) is the second
leading cause of cancer death in the United States}
but that may be changing. Research shows that
knowing the genetic and molecular makeup of your
colorectal tumor may lead to safer, more

effective treatment, just for you.

Make it personal. It's your tumor.

Talk to your doctor about testing your tumor.
Speak up. Ask questions.

Go to SU2C.org/colorectalcancer to learn more.

Greg Kinnear, SU2C Ambassador

colorectal cancer is theé'Second leading cause of cancer death
in the United States when men and women are combined.
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CREATE

How to calculate print size
for your photos

A little bit of easy math is all it takes to make sure your prints look their best.

BY LESA SNIDER

IMAGE BY JORGE ALEJANDRO
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esolution is one of the most commonly misunder-
stood concepts in digital imaging, though it’s crucial
when printing your mementos. You could trudge
through life without understanding resolution, and

the Print dialog box in most apps and most online print labs
alert you if you dont have enough of it to print. However,
mastering resolution enables you to figure out not only what
size prints you can make from your pictures but also what the

quality will be.

WHAT IS RESOLUTION?

Your digital pictures are made from
thousands of tiny blocks of color called
pixels. If you zoom far enough into a
photo in an image editing app, you can
see them individually (you’ll need to
squint to see them in Photos as you
can only zoom in to 200 percent).

Contrary to popular belief, pixels
have no predetermined size, which is
where resolution enters the, uh,
picture. Resolution is the measurement
that determines how many pixels get
packed into a linear inch in an image,
which therefore controls how big or
small the pixels are. With that in mind,
you may find it helpful to think of
resolution as pixel size (though pixel
density is more accurate).

On your computer screen, resolu-
tion is measured in terms of pixels
per inch in the U.S. (ppi, as folks
typically call it); in most other coun-
tries, it's measured in pixels per
centimeter (ppc). Scanners and

Coft oXar.oom

BY ZOOMING way into this
photo (to 3,200 percentin
Photoshop, to be exact), you
can see the individual pixels
that make up a tiny section
of this sunflower.

printers, on the other hand, refer to
resolution as dots per inch (dpi).

The higher the resolution of an
image, the smaller the pixels. Small
pixels make for smooth, high-quality
prints. The lower the resolution, the
bigger the pixels, which makes for
blocky prints resembling a pile of
Legos.

Generally speaking, you need a
resolution of at least 240 ppi to
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produce a nice print on most inkjet
printers and online printing services.
However, if you forked out big bucks
for an inkjet printer that can spray ink
at higher resolutions—say, 1440 dpi
or 2880 dpi—you can sometimes get
a better result by aiming for a higher
resolution in your calculation.

WHY YOU SHOULD CARE
ABOUT RESOLUTION

To keep things simple, Apple Photos
won't let you see image resolution,
much less change it. Adobe Photo-
shop Lightroom doesn’t flaunt the
setting either; you only encounter it
when exporting images. Why?
Because those apps calculate the
resolution for you whenever you ask

Coft oXar.oom
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PHOTOS’ Info

Photos panel

Shared m Proje

23 of 42

Add a Title
lesa_hair-5-3.jpg
December 16, 2015 2:24 PM

No camera information

3860 x

Add a Description

Add a Keyword

Add Faces

Assign a Location

them to print an image at a certain
size; if you don’t have enough
resolution, the app tells you so.

Other apps, such as Adobe Photo-
shop, Photoshop Elements, and
Pixelmator also alert you to resolution
deficiency in their print dialog boxes
but they also let you fiddle with the
resolution setting in their Image Size
dialog boxes. If you don’t know what
you're doing, increasing resolution
can trash an image because the app
will add (interpolate) fake pixels that
weren’t really captured.

Now, this column isn’t about
whether you should or shouldn’t
change resolution or even how to
do it in those apps. This column is
about empowering you to calculate
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resolution manually using the
image’s pixel dimensions and the
size of the print you want to make.
Doing so lets you know exactly what
level of quality to expect from
printing at a certain size. And if the
resolution you calculate isn’t high
enough to print at, say, 8 by 10
inches, then you can make an
informed decision to print at a
smaller size before wasting time and
money. Besides, if you always shoot
with the same cameras at the same
quality settings, you only have to
calculate resolution a few times to
learn what print sizes you can
expect to make from those devices.

HOW TO DO THE
CALCULATION

The first step in calculating what size
print you can make is to find the
image’s pixel dimensions and jot
them down. In Photos, select a
picture and press Command-I to
open the Info panel. The dimensions
appear in the second section of the
panel.

In Pixelmator, choose Window »
Info Bar and the dimensions appear
at the top of the image window.

In Photoshop Lightroom the
dimensions are visible in the Library
module in the Metadata panel. In
Photoshop and Photoshop Elements,

PIXELMATOR
DISPLAYS
dimensions in
the Info Bar.

Mode:

W 2109
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point your cursor at the Status bar at

the lower left and then click and hold
down your mouse button to make the
dimensions appear.

Next, open your Mac’s Calculator
app and divide the longest edge of
your image (measured in pixels) by
the longest edge of your desired
print size (measured in inches). For
example, if an image measures 3,840
by 5,760 pixels and you want an
8-by-10-inch print, take the longest
edge in pixels and divide it by the
longest edge in inches of the target
print size: 5,760 pixels + 10 inches =
576 ppi. That's more than enough
resolution to produce an awesome
print; remember, you need a mini-
mum of 240 ppi though it really
depends on the printer. However, if
you want make a 30-by-20-inch
poster out of that image, you’d have
a resolution of 192 ppi (5,760 + 30),
which isn’t high enough to print well.
Since big prints aren’t cheap, you’ll
wisely decide on a smaller size and
you’ll be more satisfied with the
results.

As you can see, all it takes to
calculate print size is a little know-
how and a little math. Until next time,
may the creative force be with you
alllm

Adobe Photoshop CC 2015
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How to make gorgeous landscape
panoramas with Adobe Lightroom’s
new Boundary Warp

Adobe’s Creative Cloud update to Lightroom offers a quick fix for vexing pano problem.

BY JACKIE DOVE
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(od:{7.yJ8 ADOBE LIGHTROOM BOUNDARY WARP

n a brand-new update made available only to Lightroom’s
Creative Cloud subscribers, Adobe has launched a feature
that is sure to delight panorama fanatics: Boundary Warp (go.
macworld.com/boundarywarp).

The object is to protect parts of a ary Warp offers a greater degree of

stitched image that would otherwise control than in the past.

be cut off with a typical rectangular Even if you shot your images in IMPORT IMAGES
crop. Lightroom’s Photo Merge vertical orientation with height in DIRECTLY from
feat imolifies th f ind. Light R feat your camera card,
eature simplifies the process o mind, Lightroom’s panorama feature Dropbox, or a folder
photo stitching, and the new Bound- might still cut off outlying edges of onyour hard drive.

[ il new-2.ircat - Adobe P

[
:

i
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your stitched image. As you shoot,
it's sometimes hard to tell exactly
what you’ll have to later discard.

This oddly named feature restores
full edge content to panorama
landscapes. Here’s how to use it.

1. Launch Lightroom and choose
the Library module to select the
images you want to include in your
pano.

A panorama consists of two or
more images, shot in sequence,
which can be stitched together to
display the kind of broad scenic
expanse that the eye can easily
perceive but which the camera does

Coft oXar.oom

not automatically capture.

You don’t need any special
equipment or preparation to create
a pano: Just use your favorite
camera and a standard lens, choose
a vista, and frame a series of shots
as you gradually rotate your body. A
tripod is extremely helpful for
keeping each frame in alignment,
but it is not strictly necessary. If your
camera has a built-in level, that will
work just fine, too.

Vertical images are generally
preferred for panos to capture as
much height in the image as possible.

Though Lightroom’s Photo Merge
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you want to include
from your Lightroom
library.
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feature is designed to work with Raw

files that offer enhanced flexibility and
dynamic range, you can easily build a
pano with either Raw or JPEG files.

Note that your pano is not con-
strained by the number of images
you use, but by the output size
supported by the app. Both Light-
room and Adobe Camera Raw have a
maximum image size of 65,000
pixels on the longest edge or a total
of 512 megapixels, whichever is
reached first.

2. Once you have chosen the
images, switch to the Develop
module and find Photo » Photo
Merge » Panorama.

The Photo Merge tool has two
built-in functions: HDR and Pan-
orama, and you can choose to use
both on your pano images.

Bracketing each image will give
you a choice of the best exposure for
your pano, letting you use the HDR
function to start off with the best
images. But it is not strictly neces-
sary.

Tip: If you do use both functions,
start with HDR first, and then follow
with Panorama. But you can easily
build a beautiful pano with a series of
single shots, as shown.

3. Choose a projection model for
your final image.

Lightroom’s pano stitching feature
offers several options: You can let
Lightroom automatically pick a

Coft oXar.oom
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projection model for you or you can
choose one yourself. Beginners will
do just fine letting Lightroom do the
work, but a quick click through the
different choices shows you a
preview of what the finished
sequence will look like with each.
Auto Crop will trim your picture,
while shaving off some of its edges.
That may not be a problem for every

AFTER SELECTING
YOUR photos, find
the panorama option
under the Photo
menu.

pano, but if it is, Boundary Warp will
come to the rescue.

The Spherical projection is best for
landscapes. It distorts the image as if

File Edn Luaryve‘mr; View Window Help
Add to Quick Collection and Next

Open in Loupe

Go to Folder in Library
lLock to Second Manitor

Edit in

Stacking

Pecple
Create Virtual Copies

Rotate Left (CCW)
Rotate Right (CW)
Flip Horizontal
Flip Vertical

Set Flag
Set Rating

Set Color Label
Auto Advance

Set Keyword
Change Keywords...

Develop Settings

Remove Photos...
Remove and Trash Photos...
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it were based on a sphere. Most
often, Lightroom will automatically
pick this projection.

The Cylindrical option is something
of a hybrid that will try to keep the
vertical lines of the image straight but
may wind up distorting non-vertical
parts of the image. The visual distinc-
tion between it and Spherical is
subtle and the one you use depends
on the image.

The Perspective choice is best for
architectural renderings and build-
ings where you want to preserve
horizontal or vertical straight lines.
This model tries seeks a reference
frame in the middle of the image to
maintain all straight lines.

Because the algorithm is designed
to maintain straight lines, a warp
operation defeats the purpose.

4. Adjust the image manually by
using the Auto Crop and Boundary
Warp slider together.

The slider preserves important

Coft oXar.oom

Panorama Merge Praview

information for the edges of the
picture that you might otherwise
have cropped out.

But you may not want to restore
every detail from the four corners of
your image, so if you enable Auto
Crop, you can move the slider to
cover just the part of the image
you’re concerned about and stop
when you're satisfied. Then click
Merge.

Lightroom will then process the
pano and deposit it in your Library.

Tip: Processing panoramas
requires adequate disk space, so
make sure you have enough space
on your hard drive for the function to
work.

5. Add finishing touches in the
Develop module.

Once you generate your pan-
orama, it doesn’t have to end there.
Sometimes, you'll still need adjust-
ments to exposure, contrast, sharp-
ness, and other elements to make
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your image shine. Just access your S
image from the Develop module and
proceed as with any other image.

Normally, you don’t have to worry
about lens profiles as Lightroom has
so many built in that it will automati-
cally choose the right one. Nonethe-
less, if you do get a Lens Profile error
message, just check Enable Profile
Corrections and Remove Chromatic
Aberration in the Lens Corrections
Basic tab in the Develop module. The
Profile tab records the default Lens
Profile and other information.

Try Boundary Warp out on some of
your older images first just to check it
out. | recruited some old JPEGs | shot
years ago, and it worked nicely.
Then, next time you try for a sweep-
ing vista, remember to keep your
camera at a vertical orientation,
bracket each shot, use the Photo Boundary Warp feature yet, as it was  YOUCANUSEBoundary

Merge » HDR function first on each released to Creative Cloud subscrib- ~ Warp with Auto Crop
or by itself, if you want

frame, and then finish up with the ers first. It will be available to every- to preserve edge
Boundary Warp pano. one when Lightroom releases its content.
Photographers with a perpetual next general update. Adobe is mum
Lightroom license do not have the on exactly when that will be. ®m
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Answering Your Questions and Sharing Your
Tips About Getting the Most From Your Mac

Apple Ila" -

nage your Apple account

B Remember me

Forgot Apple ID_geBassword

Mac 911

Solutions to your most vexing Mac problems.

I have multiple Apple IDs. What happens if | delete one?

Q: | do indeed have two Apple ID accounts and it appears that my iPhone

and iPad are listed as the two devices on one account (the one | use to
sign into iTunes with). My laptop is listed as the device on the other
account. | am afraid to delete the ID that my computer is linked to for fear
that | will not be able to reconnect it/sign it into the Apple ID account that
has the iPhone and iPad. If | delete the apple ID with the computer listed
as the device, will | be able to start fresh and add my computer to the
Apple ID account with the other two devices?

— Nicole Max
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MAC 911

A: There’s no problem in what you
suggest: You can use any Apple ID to
sign into any device for iTunes,
iCloud, iMessage, and more. (Some
older Apple ID accounts might give
you trouble with iCloud and related
services, but they have to be more
than several years old.)

You can always sign out of an
Apple ID on any iOS device or Mac,
too, without rendering that hardware
incapable of logging in with another
account.

However, if you’ve made any
purchases with an Apple ID, those
purchases can’t be transferred or
merged—they’re permanently
connected with the account that
bought them.

As Apple notes in one of its help
documents (go.macworld.com/
idsupport): We recommend that you
use the same Apple ID for all Apple
services on your device—including
the iTunes & App Stores and iCloud.
Using multiple Apple IDs might be
confusing and cause issues with
accessing purchased content or
using some services. If you have
multiple Apple IDs, you can’t merge
them.

For historical reasons, because of
how | originally set up an iTools
account (thanks, Geoff Duncan, for
snagging the short ID for me back in
2000) and later an iTunes account, |

still maintain two separate pres-
ences. | use what is now an iCloud
account for syncing, iMessage, and
other data-based services, and my
upgraded-from-iTools-through-
.Mac-through-MobileMe-to-iCloud
Apple ID for all my media purchases.
It can be irritating to have to enter
different passwords repeatedly at
different points in setting up a new
device or when upgrading, but it has
allowed me to keep all my pur-
chases intact.

How to manage media
when migrating to a Mac
with a smaller drive

“Bass Hound” writes in with a set of
interlocking problems. Their new
computer has a 128GB drive while
the old one was 512GB. They have
a Time Capsule backup and
wonder if they can make choices
while restoring the backup. While
they’ve opted into iCloud Photo
Library, they “have not, however,
joined Apple Music because | don’t
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want to pay the ongoing fee.”
Finally, they’d like to “add all my
media—music, movies and possibly
pics—to an external drive.”

A: This is not an uncommon collec-
tion of questions, so I'll do my best to
knock them all out.

First, you can use Migration
Assistant (go.macworld.com/
migrationasst) instead of OS X
Recovery to restore just Applications,
certain user (Home) directories, and
other files. That may be a good place
to start with a fresh computer.

Second, Apple Music doesn’t include
iTunes Match, the service that syncs
your current music library, including
uploading files that don’t match tunes in
Apple’s music store. Kirk McElhearn ran
down the way those two subscription
services interact (go.macworld.com/
matchmusic) last July. There is an

Is there a way to sort Safari
bookmarks?

Q: | recently edited my bookmarks,
and the links | created in each
folder changed to be in alphabeti-
cal order. Yikes! | needed them to
stay in chronological order.
Any way to fix this?

— Christine Girone

A: What's peculiar about
this? Safari doesn’t

feature a way to alphabet-
ize bookmarks! There is no
built-in way to sort bookmarks (or
URLSs) alphabetically in Safari. So I'm
not sure what happened that caused
this spontaneous reshuffle.

If you were to want alphabetic
sorting of bookmarks, there’s a free
and up-to-date
donationware app Tl

’4/"““\‘\

)

ongoing fee ($25 per year) for iTunes called SafariSort (go. SAFARI DOESN'T
Match, but less than the $10 a month for ~ macworld.com/ FEATURE A WAY
Apple Music if you don’'t want or need safarisoft) that you TO ALPHABETIZE
that. could turn to. (It's an BOOKMARKS!

Finally, you can store iTunes libraries unsigned app,

requiring that you

bypass Gatekeeper, but it's been in

development for years. Make your

own decisions about whether to run

it or not, but there are no red flags.)
If you sort out what happened,

Christine, let us know.

(go.macworld.com/moveituneslib)
media (music, videos, and locally
downloaded iOS apps) and your Photos
library (go.mac world.com/externaldrive
photos) on an external drive, or even a
network-attached server (go.macworld.
com/itunesnas).
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MAC 911

How to fix the t.co Twitter
problem

If you're a Twitter user, you’ve seen
the t.co domain the company uses: It
rewrites all URLs in tweets to pass
through this redirecting domain to
track “engagement.” It wants to know
how many times links are passed—
ostensibly, it could also filter against
malware and spam, though I've never
seen such a mechanism engaged.

But for years, some
Twitter users in OS X
have had a problem with
t.co in Safari. Instead of
redirecting, the link
results in an endlessly
loading page that times
out. Reloading the page results in a
non-existent domain. Reload again,
and the destination URL finally loads.

What'’s up with that? Nobody
knows! Or at least, nobody did. |
looked at years of forum postings all
over in which people noted the
problem, and no one had a consis-
tent solution. That appears about to
change.

An Apple engineer who works on
the WebKit team—the technology
underneath Safari—recently tweeted
in response (go.macworld.com/
tcosafari) to well-known Mac devel-
oper Rich Siegel and developer and
podcaster John Siracusa that the
problem has been identified, and a
fix is underway. So relief is coming.

In the meantime, developer Stef
Pause recommends a command-line fix
you can issue in Terminal, if you've got
the stomach for it! Enter the following
and press Return: dscacheutil
-flushcache

This command dumps the domain
name system (DNS) cache, which is a
temporary repository of relatively
recently retrieved values for linking
human-readable domain names with
the actual numbers and other
bits of Internet plumbing
needed for connections. Pause
writes that it might need to be
entered multiple times.

Another option, if you're
using Tweetbot for OS X is to
change a setting via Terminal that turns
off URL rewriting. (This tip via Dermot
Daly on Twitter.) Enter this command
and press Return: defaults write
com. tapbots.TweetbhotMac
OpenURLsDirectly YES m

AskMac 91l

We’re always looking for problems
to solve! Email us at mac911@
macworld.com including screen
captures as appropriate.

Mac 911 can’t provide direct email
responses or answers for every
question. For that, turn to Apple-
Care, an Apple Store Genius Bar, or
the Apple Support Communities.
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